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Abstract 

 

The Ground-Based Monitoring R&E Component Evaluation project performs testing 

on the hardware components that make up Seismic and Infrasound monitoring 

systems.  The majority of the testing is focused on the Digital Waveform Recorder 

(DWR), Seismic Sensor, and Infrasound Sensor.  The software tool used to capture 

and analyze the data collected from testing is called TALENT:  Test and Analysis 

Evaluation Tool.  This document is the manual for using TALENT. Other reports 

document the testing procedures that are in place (Kromer, 2007) and the algorithms 

employed in the test analysis (Merchant, 2011). 
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NOMENCLATURE 
 

 

dB Decibel 

DOE Department of Energy 

DFT Discrete Fourier Transform 

DUT Device Under Test 

DWR Digital Waveform Recorder 

FFT Fast Fourier Transform 

GNEMRE Ground-based Nuclear Explosion Monitoring Research & Engineering (Program 

within NA22) 

NA22 Office of Non-proliferation Research & Development (Office within NNSA) 

NNSA National Nuclear Security Administration (Office within DOE) 

PDF Probability Density Function 

PSD Power Spectral Density 

RMS Root Mean Square 

SNL Sandia National Laboratories 

Tester The individual responsible for performing a given test and the associated analysis 
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1 INTRODUCTION 
 

1.1 Background 
 

TALENT is designed to be a single, standard interface to all test configuration, metadata, 

parameters, waveforms, and results that are generated in the course of testing monitoring 

systems.  It provides traceability by capturing everything about a test that is required to 

reproduce the results of that test.  It consists of two basic components:  A table of contents and a 

desktop.  Users can browse to the devices and tests within the table of contents and display the 

associated device configurations and test interfaces within the desktop. 

 

1.2 Development History 
 

Development of TALENT began in mid-2007 with an initial investigation into understanding the 

algorithms that were in place in the existing software utilities used by the Component Evaluation 

project.  It quickly developed into a basic architecture for capturing generic test metadata in a 

relational database and integrated user interfaces for reading data and analyzing test results.  

Over time, additional tests and functionality have been added to better capture the scope of 

testing that takes place. 

 

1.3 Creators and Contributors 
 

The design and development of TALENT was performed by John Merchant, Gary Huang, and 

Andre Encarnacao of Sandia National Laboratories. 

 

1.4 Typographic Conventions 
 

This manual uses (or tries to!) the following typographical conventions: 

 

Italics Book titles, names of sections in the manual, computer files and 

directories. 

Bold  Key names, module names, menu names, button names, selectable items  

 

When indicating an option of a pulldown menu, we use the notation:  

 

Menu → Option 

 

If there is an option within a submenu you may see:  

 

Menu → Submenu → Suboption 
 

Selection commands for displayed objects assume that the user has a standard 3-button mouse. 

“Left-click” , “Center-click”, or “Right-click” means a single click with the left, center, or right 

button, respectively. “Double-click” means two clicks in rapid succession. “Two-single- clicks” 

means two separate clicks, in moderate succession. If no left, center, or right is specified for a 

click, assume left. 



10  

  



11  

2 SYSTEM SETUP 
 

2.1 Platform Requirements 
 

TALENT was developed primarily on a Windows XP and Windows 7 development 

environment.  TALENT was written entirely in Java, a platform independent programming 

language, and should be able to run on any platform that has Java installed.  There are no 

licensing requirements for running TALENT.  The only software needed is a copy of the Java 

Virtual Machine version 1.5 or greater, which is freely available from Oracle. 

 

2.2 Database Requirements 
 

The contents of TALENT are stored in, and retrieved from, a relational database.  Having a 

database is necessary for being able to retain changes in the TALENT contents between sessions.  

TALENT’s database implementation should be able to support any SQL database for which 

there is a JDBC (Java Database Connection) driver available.  TALENT is distributed with an 

Oracle and JavaDB driver.  The JavaDB driver provides for a local database on the client 

computer, stored in binary files on disk, for the case when an external database is not available.  

No user setup of a JavaDB database is required, other than directing the program where to save 

the files to disk. 

 

TALENT will automatically examine any database that it is directed to in order to identify the 

necessary database tables.  If the tables exist, then the application will make use of those tables.  

If any of the tables do not exist or are missing necessary fields, then the application will make 

the necessary modification to the database tables.   

 

2.3 Configuration 
 

To run TALENT, the user must simply execute the file talent.jar, which contains all compiled 

code needed for the application, by double clicking the file.  Note that the operating system file 

association must be configured appropriately for this to work.  Alternatively, the following 

command may be typed at the command line: 

  

 java –jar talent.jar  

 

Note that java by default only allocates 64 megabytes of memory for its applications.  It may be 

necessary to increase that amount depending upon the volume of data that is to be loaded within 

TALENT.  The following virtual machine setting may be specified to increase the allocated 

memory: 

 

-Xmx???m 

 

Where ??? is the amount of memory of megabytes.  In typical use, an amount of 1000 megabytes 

has worked well.  This virtual machine setting may either be included in the command line, by 

configuring the operating system’s file type association, or added to the runtime operations using 

JVM Options within the Windows Control Panel. 
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The only other configuration change needed to run TALENT is to set it up to the appropriate 

database.  This can be performed by starting the application and then adjusting the database 

settings from the File → Database → Setup Database menu item. 

 

TALENT will automatically create a file called talent.properties within the user’s current 

working directory upon startup.  Any configuration changes made to TALENT will be 

automatically stored in this file and used whenever the application is run the next time. 
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3 APPLICATION DESKTOP 
 

When the user starts the TALENT application, they are prompted to log in to the database to 

which they are connecting to by entering the appropriate username and password into the dialog 

shown below. 

 

 
 

The username may be selected from a drop-down list of usernames that have been setup within 

the database.  Until the user logs in with a valid username and password, they will be unable 

connect to the database or interact with any of the content of that database.  There is very limited 

functionality within the TALENT application when it is not connected to a database. 

  

The first time that TALENT connects to a newly created database, the application will prompt 

the user to create a special user login with administrative privileges, as shown in the dialog 

below.  At all other times, the user must login with a username and password prior to finalizing 

the connection to the database.  
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Once the user is logged in, they are then presented with the main application desktop shown 

below.  The primary components that make up the application are the Menu Controls, Table of 

Contents, and Desktop.  The Menu Controls provide the user with access to additional menu 

items and controls for interacting with TALENT.  The Table of Contents displays the 

hierarchical structure stored in the database of devices and tests that have been saved.  The 

Desktop is the location where the various viewers for items stored within the database will be 

displayed.  Additional information about each of these application components is provided in 

subsequent sections of this manual. 
 

 
 

3.1 Menu Controls 
 

3.1.1 File 
 

3.1.1.1 Database 

 

The Database submenu provides menu items for configuring and managing the database 

connection. 

Menu Controls 
Desktop 

Table of 

Contents 
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3.1.1.1.1 Setup Database 
 

The connection to the database may be configured by selecting the File → Database → Setup 

Database…  menu item.  The user is presented with a dialog shown below.  Different tabs across 

the top of the dialog may be selected to choose the various types of databases available.  

Currently, only two types of databases are supported:  Oracle and Derby. 

 

 
 

 

If an Oracle database is selected, then the necessary connection parameters must be entered for 

the desired database location: 

 

Server Name The hostname of the computer on which the Oracle 

server is running. 

Server Port The TCP/IP Port on which the Oracle server is 

running. 

Database SID The SID for the Oracle server. 

SQL Username The username of the database account. 

SQL Password The password of the database account. 

Auto Commit A flag indicating whether the database connection is 

in auto commit mode.  If auto commit is enabled, then 

any changes made to the database content are 

automatically stored within the database.  If auto 

commit is disabled, then any changes made are 

considered to be temporary until they are manually 

committed or undone. 

 

Note that if auto commit is disabled, any uncommitted 

changes will be lost in the event that the application 

aborts abnormally. 
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A Derby database is a local, within-application database that makes use of a set of binary files on 

disk to store the database content.  No installation or setup is necessary to make use of a Derby 

database.  Support for Apache Derby is built in to the TALENT application. 

 

 
 

 

If a Derby database is selected, then the necessary connection parameters must be entered for the 

desired database location: 

 

Database name The folder location in which the Derby database files 

are stored.  The folder location may be relative or 

absolute.  If relative, it is relative to the current 

working directory in which the application was 

launched.  If absolute, the folder location must include 

the full path name (i.e. c:\workfiles\TestDB). 

SQL Username The username of the database account.  This field is 

typically empty for a Derby database. 

SQL Password The password of the database account.  This field is 

typically empty for a Derby database. 

Auto Commit A flag indicating whether the database connection is 

in auto commit mode.  If auto commit is enabled, then 

any changes made to the database content are 

automatically stored within the database.  If auto 

commit is disabled, then any changes made are 

considered to be temporary until they are manually 

committed or undone. 

 

Note that if auto commit is disabled, any uncommitted 

changes will be lost in the event that the application 

aborts abnormally. 
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3.1.1.1.2 Commit 
 

The File → Database → Commit menu item is only enabled if the current database connection 

has the Auto Commit parameter within the Database Setup dialog disabled.  

 

If selected, this menu item will store the most recent changes, since the connection was made or 

the most recent Commit or Undo, to the database. 

3.1.1.1.3 Undo 
 

The File → Database → Undo menu item is only enabled if the current database connection has 

the Auto Commit parameter within the Database Setup dialog disabled.  

 

If selected, this menu item will discard any recent changes made.  The database content will be 

rolled back to the point at which the database connection was made or the most recent Commit 

or Undo operation was performed. 

3.1.1.1.4 Switch User 
 

The File → Database → Switch User menu item allows a user to login to the existing database 

connection as a different user.  The dialog below is shown. 
 

 
 

3.1.1.1.5 User Manager 
 

The File → Database → User Manager menu item allows a user to make modifications to their 

own or other user accounts.  Note that regular users are only allowed to change their passwords.  

Only administrative users are allowed to create users, delete users, or to make other users an 

administrator. 

 

When the User Manager dialog first appears, as shown below, the user can change their 

password by entering a new password and clicking the Set Password button. 
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By switching to the Modify Users tab, shown below, an Administrator can create a new user by 

clicking on the  icon.  An Administrator can delete a user by selecting the user within the list 

and clicking on the  icon. 

 

 
 

In addition, an Administrator may make additional changes to a user by right-clicking on a 

username and selecting the desired item from the popup menu.  An Administrator may toggle 

another user’s administrator setting, change a user’s password, or delete a user. 
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Note that an Administrator is not allowed to delete their own user account or revoke 

administrative privileges from themselves.  This constraint was implemented to ensure that there 

would always be at least one user account with administrative privileges. 

 

3.1.1.1.6 Import / Export 
 

The File → Database → Import/Export menu item brings up a dialog, shown below, that 

allows the user to transfer the database contents from one database to another. 
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The user must first enter the database connection details for Database #1 and Database #2 and 

click the Connect button within each of the panels to make the connections. 

 

When connected to a database, each database panels contains entries for all of the types of 

information that TALENT can capture:   Table of Contents, Procedures, Test Plans, Models, and 

Responses. 

 

Transfer 

Content Arrows 
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Once both of the database connections have been made, the user can transfer database contents 

between the two databases via a drag and drop operation.  If the user wishes to copy the entire 

contents of one of the database into the other, they may do so simply by clicking on one of the 

transfer content arrows. 

 

Note that if using a Derby database, do not attempt to connect either of the database 

import/export panels to the same Derby database that the main application table of contents is 

connected to.  This will result in the application freezing for some amount of time before 

returning an error. 

 

Once the user is finished with the Database Import/Export tool, they may close the dialog by 

click on the red X in the upper right corner of the window. 

 

3.1.1.2 Properties 
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3.1.1.2.1 Edit 
 

The File → Properties → Edit menu item brings up a dialog that allows the user to customize 

some of the behavior and appearance of the TALENT application by setting parameters.  The 

parameters are divided into tabs according to their application.  The following sections describe 

each of the tabs. 

 

Note that any changes to these parameters are automatically saved in the talent.properties 

configured file located in the current working directory.  The next time that the application is 

started, these parameters are automatically loaded from the parameter file.  This allows a user to 

retain a specific set of customizations. 

 

If there are any viewers currently open when a change is made to any of the parameters, then the 

viewers may need to be closed and re-opened in order for the changed properties to take effect. 

3.1.1.2.1.1 General Properties 
 

The General tab contains parameters that apply to the main application figure and all dialogs 

that are created. 
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TOC Font Size Text font size in points for the table of contents. 

TOC 

Background 

Color 

Background color of the table of contents.  Click on the color 

swatch to open a color chooser dialog and select a different color. 

Desktop 

Background 

Color 

Background color of the application desktop.  Click on the color 

swatch to open a color chooser dialog and select a different color. 

Displacement 

Unit 

The preferred unit of displacement that will be used in 

representing all numeric values and plots. 

Velocity Unit The preferred unit of velocity that will be used in representing all 
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numeric values and plots. 

Acceleration 

Unit 

The preferred unit of acceleration that will be used in representing 

all numeric values and plots. 

Pressure Unit The preferred unit of pressure that will be used in representing all 

numeric values and plots. 

Voltage Unit The preferred unit of voltage that will be used in representing all 

numeric values and plots. 

Time Unit The preferred unit of time that will be used in representing all 

numeric values and plots. 

Waveform 

Archive 

The location that TALENT will read from when acquiring data 

from digitizers during the automated execution of tests.  The 

archive location may specify either an individual file or a folder.  

If a folder is designated, then TALENT will examine all files in 

the designated folder for waveforms.  The files may be in any 

format that the application is able to read.   

 

The folder location supports tags embedded within the path in 

order to support a dynamic set of files or directories.  For numeric 

values, the number of pattern letters is the minimum number of 

digits, and shorter numbers are zero-padded to this amount.  For 

text values, if the number of pattern letters is 4 or more, the full 

form is used; otherwise a short or abbreviated form is used if 

available. 

 

TAG Description Example 

%STA% Station Code of 

the digitizer 

 

%CHAN% Channel Code 

of the digitizer 

 

%G% Era AD 

%yy% 

%yyyy% 

%yyyyy% 

Year 11 

2011 

02011 

%M% 

%MM% 

%MMM% 

%MMMM% 

Month in year 7 

07 

Jul 

July 

%w% 

%ww% 

Week in year 29 

09 

%W% 

%WW% 

Week in Month 2 

02 

%D% 

%DD% 

%DDD% 

Day in year 189 

08 

008 
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%d% 

%dd% 

Day in month 10 

08 

%F% Day of week in 

month 

2 

%EEE% 

%EEEE% 

Day in week Tue 

Tuesday 

%a% AM/PM AM 

%H% 

%HH% 

Hour in day 

(0-23) 

0 

00 

%k% 

%kk% 

Hour in day  

(1-24) 

1 

01 

%K% 

%KK% 

Hour in am/pm 

(0-11) 

0 

00 

%h% 

%hh% 

Hour in am/pm 

(1-12) 

1 

01 

%m% 

%mm% 

Minute in hour 30 

08 

%s% 

%ss% 

Second in 

minute 

55 

06 

%S% 

%SS% 

%SSS% 

Millisecond 978 

05 

005 

%z% 

%zzzz% 

General Time 

zone 

GMT 

Greenwich Mean Time 

%Z% RFC 822 time 

zone 

-0800 

 

For example, the folder location: 

 

C:\rawData\%yyyy%\%DDD% 

 

For reading waveform data from May 16, 2011 would be 

interpreted as: 

 

C:\rawData\2011\136 

 

Waveform 

Delay 

The amount of time that TALENT will wait for the data to be 

available within the Waveform Archive.  This delay is to allow for 

any latency inherent in the digitizer recording, communicating the 

data to a server, and storing the data in the archive location. 

 

For example, if a test is being executed and needs to read 30 

seconds of data from the waveform archive and there is a 10 

second delay, then TALENT will wait for 40 seconds (30 + 10) 

before attempting to read the waveform data from the archive. 
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3.1.1.2.1.2 Waveform Viewer Properties 
 

The Waveform Viewer tab contains parameters that apply to the waveform viewer panels within 

the Test Viewers. 

 

 
 

 

Chart Height Height of the waveform viewer in pixels. 

Line Width Line width of the waveform time series line in points. 

Gridline Width Line width of the plot gridlines in points. 

Label Font Size Font size of the axes labels in points. 
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Set Anti-Alias Flag to control whether the plotted lines are smoothed 

using an anti-alias filter. 

Time Window 

Border Only 

Flag to control whether the waveform time window 

markers are visible as a filled swatch or just a border 

line.  This parameter only affects how the clipboard 

image, saved image, and generated report are 

displayed.  It has no effect on the display of the 

waveform viewer within the application. 

Background 

Color 

Background color of the waveform viewer.  Click on 

the color swatch to open a color chooser dialog and 

select a different color. 

Line Color Line color of the waveform time-series.  Click on the 

color swatch to open a color chooser dialog and select 

a different color. 

Gridline Color Color of the plot gridlines.  Click on the color swatch 

to open a color chooser dialog and select a different 

color. 

3.1.1.2.1.3 PSD Viewer Properties 
 

The PSD Viewer tab contains parameters that apply to the PSD viewer panel within the Test 

Viewers. 
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Chart Height Height of the PSD Viewer in pixels. 

Line Width Line width of the PSD lines in points. 

Model Line 

Width 

Line width of the model lines in points. 

Gridline Width Line width of the plot gridlines in points 

Label Font Size Font size of the axes labels in points. 

Set Anti-Alias Flag to control whether the plotted lines are smoothed 

using an anti-alias filter. 
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Background 

Color 

Background color of the waveform viewer.  Click on 

the color swatch to open a color chooser dialog and 

select a different color. 

Gridline Color Color of the plot gridlines.  Click on the color swatch 

to open a color chooser dialog and select a different 

color. 

Line Colors Number of defined colors within the palette for 

plotting the PSD lines.  Each line is plotted in its 

respective color according to the order.  The first line 

is plotted in the first color, the second line in the 

second color, and so on.  If there are more lines than 

defined colors, then the chosen color wraps back 

around to the beginning of the palette. Click on the 

color swatch to open a color chooser dialog and select 

a different color. 

Model Line 

Colors 

Number of defined colors within the palette for 

plotting the Model lines.  Each line is plotted in its 

respective color according to the order.  The first line 

is plotted in the first color, the second line in the 

second color, and so on.  If there are more lines than 

defined colors, then the chosen color wraps back 

around to the beginning of the palette. Click on the 

color swatch to open a color chooser dialog and select 

a different color. 

 

3.1.1.2.1.4 Chart Viewer Properties 
 

The Chart Viewer tab contains parameters that apply to any other charts within the application. 
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Chart Height Height of the chart in pixels. 

Line Width Line width of the chart lines in points. 

Gridline Width Line width of the plot gridlines in points. 

Label Font Size Font size of the axes labels in points. 

Set Anti-Alias Flag to control whether the plotted lines are smoothed 

using an anti-alias filter. 

Background 

Color 

Background color of the waveform viewer.  Click on 

the color swatch to open a color chooser dialog and 

select a different color. 



31  

Gridline Color Color of the plot gridlines.  Click on the color swatch 

to open a color chooser dialog and select a different 

color. 

Line Colors Number of defined colors within the palette for 

plotting the data lines.  Each line is plotted in its 

respective color according to the order.  The first line 

is plotted in the first color, the second line in the 

second color, and so on.  If there are more lines than 

defined colors, then the chosen color wraps back 

around to the beginning of the palette. Click on the 

color swatch to open a color chooser dialog and select 

a different color. 

 

3.1.1.2.2 Load 
 

The File → Properties → Load menu item allows a user to load the properties from an external 

file into the current application session using a file chooser similar to the one shown below.  
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3.1.1.2.3 Save 
 

The File → Properties → Save menu item allows a user to save the properties for the current 

application session to an external file using a file chooser similar to the one shown below. 

  

 
 

3.1.1.3 Exit 

 

The File → Exit menu item exits the application.  Prior to exiting, the application checks to 

ensure that all of the viewers and the database changes have been committed to the database.  If 

there are any uncommitted changes, the application will prompt the user for their desired course 

of action with the dialog shown below:  
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Click Yes to commit the changes to the database and then exit.  Click No to exit without 

committing changes to the database.  Click Cancel to abort the exit without committing any 

changes to the database. 

 

3.1.2 View 
 

3.1.2.1 Responses 

 

The View → Responses menu item opens a dialog for managing the responses stored in the 

database.  See the section on responses for additional detail. 

 

3.1.2.2 Models 

 

The View → Models menu item opens a dialog for managing the models stored in the database.  

See the section on models for additional detail. 

 

3.1.2.3 Filters 

 

The View → Filters menu item opens a dialog that allows the user to design several types of 

filters and observe the magnitude and phase response, impulse response, and digital pole/zero 

locations of the filter. 

 

 
 

Filter Type Select the type of filter to design from the options in 

the provided pull down menu:  Butterworth, 

Chebyshev 1, Chebyshev 2, and Bessel. 

Band Type Select the type of filter band from the options in the 

provided pull down menu:  Low Pass, High Pass, 
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Band Pass, and Band Stop. 

Zero Phase Flag to control whether the filter is zero-phase.  This 

option is sometimes also referred to as non-causal. 

Filter Order The order of the filter which specifies the number of 

poles and zeros. 

Frequency The low and high frequency limits for the chosen 

Band Type. 

Sample Rate The sample rate of the digital filter. 

 

3.1.2.4 Snapshot 

 

The View → Snapshot menu item creates an image of the currently selected viewer within the 

TALENT Desktop and copies that image to the clipboard.  The image on the clipboard may then 

be pasted into a document. 

  

3.1.3 Admin (Optional) 
 

The Admin menu contains menu items that are only available for the Administrator to access.  If 

the user is currently logged with a username and password that does not have the Administrator 

flag set, then the Admin menu will not be displayed or accessible. 

 

3.1.3.1 Database Dump 

 

The File → Admin → Database Dump menu item allows an Administrator to display the 

dumped out contents of each of the database tables.  The administrator can select the desired 

database table from the pull down list at the top of the dialog.  The field names and all of the 

rows within the database are displayed within the dialog. 
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3.1.3.2 Database Reset 

 

The File → Admin → Database Reset menu item allows an Administrator to drop all of the 

database tables and create new, empty tables in their place. 

 
 

Obviously, this operation will delete all data currently held in the database.   Please exercise 

caution when making use of this functionality. 

 

3.1.3.3 Procedure Editor 

 

See Test Procedures for a description of the Procedure Editor. 
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3.1.3.4 Test Plan Editor 

 

See Test Plan for a description of the Test Plan Editor. 

 

3.1.4 Help 
 

3.1.4.1 About 

 

The Help → About menu item displays the version information for the currently running 

application. 

  

 
 

3.1.4.2 Test 

 

The Help → Test menu item performs a set of self tests on the data analysis and signal 

processing routines.  The pass/fail status for each routine is shown in the dialog 

 

 
 

 

 

3.2 Table of Contents 
 

The Table of Contents (TOC) displays the hierarchical tree structure of devices and tests.  This 

tree structure is stored entirely within the database.  At the top level of the tree is the Root 

Folder shown below: 
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The TOC tree structure can contain several types of entries:  Folders, Components, Subsystems, 

Systems, and Tests.  There are specific rules that determine the allowable hierarchy of entries.  

These rules are summarized below: 

 

Folders Folders are used for organization within the TOC.  

They may be created at any level within the TOC. 

Components A Component represents a specific device that is in 

use either as a device under test, a portion of the 

Testbed, or as a portion of a Subsystem or System.  

There are several types of Components that may be 

created, such as a Digitizer or a Sensor.  See the 

Components section for additional details 

 

Components may exist at the top level of the TOC, 

within a Subsystem, or within a System.  Components 

may only contain Tests that are applied on that 

Component. 

Subsystems A Subsystem is a collection of Components that are 

grouped together as a unit for testing. 

 

Subsystems may exist at the top level of the TOC or 

within a System.  Subsystems may contain 

Components and Tests that are applied to that 

Subsystem. 

Systems A System is a collection of Subsystems that are 

grouped together as a unit for testing.  

 

Systems may exist at the top level of the TOC.  

Subsystems may contain Subsystems, Components, 

and Tests that are applied to that System. 

Tests A Test represents a specific implementation of a type 

of test on a specific device.  There are many types of 

tests.  

 

Root Folder 
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Tests may only exist below a Component, Subsystem, 

or System.  Tests are the leaf entries within the tree 

and cannot contain any other entries below 

themselves. 

 

A diagram of the allowable TOC hierarchy is shown below. 

 
3.2.1 Context Menu 
 

The user may bring up the Context Menu by selecting one or more entries in the Table of 

Contents and right-clicking with the mouse.  The specific options that are enabled within the 

Context Menu depend upon the type of entries that are selected.  

 

Root 

System Subsystem Component 

Test 
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The following actions may be selected from the Context Menu: 

 

Display Display the appropriate viewer within the Desktop for the selected 

Components, Subsystems, Systems, and Tests.  Folders cannot be 

displayed.  See the relevant section for the selected TOC entry for 

specific details on the viewer that will be displayed. 

 

The user may also perform this action by double-clicking the TOC 

entry with the left mouse button. 

Rename Change the name of the selected Component, Subsystem, System, Test, 

or Folder.  Once this action has been selected, enter the desired name 

within the edit box that appears over the selected item.  Press Enter to 

finalize the rename.  Press Esc or change focus to another portion of the 

GUI to cancel the rename operation. 

New Folder Create a new folder below the selected entry.  Once the folder has been 

created, the user may type in a name for the folder in the edit box that 

appears. 

 

New 

System 

Create a new System below the selected entry.  Once the System has 

been created, the user may type in a name for the folder in the edit box 

that appears. 

 

New 

Subsystem 

Create a new Subsystem below the selected entry.  Once the Subsystem 

has been created, the user may type in a name for the folder in the edit 

Context Menu 
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box that appears. 

 

New 

Component 

Create a new Component below the selected entry.  The user may 

select from a menu of the available components. 

 

 

New Test Create a new Test below the selected Component, System, or 

Subsystem.  The list of available tests that are displayed is dynamic 

depending upon the TOC entry that was selected.  The list of tests 

shown below are the ones available for a digitizer: 
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Implement 

Test Plan 

Create the tests for a previously defined test plan.  See the Test Plan 

section for a more detailed description. 

Set Access 

Permissions 

Set the access permissions to allow other users to read and write, read 

only, or no read and write.  See the section on User Access Permissions 

for more details. 

 

 

Copy Copy the selected TOC entries onto the clipboard. 

Paste Paste the entries on the clipboard within the selected TOC entry. 

Paste Paste a shortcut to the entries on the clipboard within the selected TOC 
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Shortcut entry. 

Go to 

Target 

If the selected TOC entry is a shortcut, open and select the TOC entry 

that the shortcut points to. 

Create 

Report 

Save a generated report to a file on disk of the selected TOC entries.  

The report is saved as an HTML file that may be opened in any web 

browser or a document editor such as Microsoft Word. 

Delete Delete the selected TOC entries.  The user will be prompted to confirm 

the deletion: 

 

 

 

3.2.2 User Access Permissions 
 

Users can limit the access permissions to portions of the TOC for which they are the author.  The 

access permissions of a TOC entry can be set by right-clicking on the selected entry and 

choosing from the available access permission options:  read, write; read only; and no read, no 

write. 

 
 

Setting the access permissions on a TOC entry automatically sets all its children within the tree 

to the same access permissions setting. 

 

Note that these user access permissions only apply to non-administrator users.  Administrator 

users are able to read and write any TOC content without restriction. 
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3.2.2.1 Read and Write 

 

Setting the access permission to “read, write” allows all other users to read and make changes to 

the content with no restrictions.  This setting is the default for all newly created TOC content. 

 

 
 

3.2.2.2 Read Only 

 

Setting the access permission to “read only” allows all other users to read the content, but not 

make changes.  TOC content that is read only is indicated with a red R overlaying the entries 

icon, as shown below: 

  

 
 

3.2.2.3 No read, No write 

 

Setting the access permission to “no read, no write” does not allow other users to read or make 

changes.  TOC content that has been flagged as having no read and no write permissions is 

indicated with a lock overlaying the entries icon, as shown below: 
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Note that if a user does not have read access permission for a folder and they attempt to expand 

the folder, they will not be able to view any of the folder contents. 

 

 

3.2.3 Drag and Drop 
 

In addition to the copy and paste using the Context Menu, users can move content from one 

location to another within the TOC by performing a drag and drop operation. 

 

The user may select one or more entries within the TOC and drag those entries to a new location 

within the TOC.  Once the entries are dropped to a new location, TALENT will automatically 

move the entries from their prior location and add them to the drop location. 

 

3.2.4 Shortcuts 
 

A user may create a shortcut, or link, to any entry within the TOC by using the Copy and paste 

Shortcut commands from within the TOC Context Menu.  A shortcut is displayed within the 

TOC using the same icon as the original entry.  However, the shortcut has a small arrow 

overlaying the icon as shown below: 
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The user may interact with the shortcut entry as if it were the original entry since the shortcut 

references the same content within the database.  Any changes made in either location are 

reflected in both locations. 

 

The user may delete the shortcut.  However, deleting the shortcut deletes just the reference and 

not the original entry. 

 

Deleting an original entry for which there are linked shortcuts results in the following warning 

message: 

 

 
 

Shortcuts are intended as an easy way for the user to reference a device or set of tests in multiple 

locations without having to duplicate the information and worry about keeping the duplication 

synchronized.  An example use case would be if the user were performing component levels tests 

on a piece of hardware that is also going to be a part of a subsystem for which there will be 

subsystem level tests.  The user will be able to keep a reference to the same piece of hardware 

organized in multiple locations within the TOC. 

 

3.3 Desktop 
 

The TALENT Desktop provides an integrated workspace for managing any viewers that are 

created for displaying database content.  In addition to the viewer dialog that is visible within the 

Desktop, each dialog window also has a corresponding button on the Taskbar.  The user may 

bring a window to the front by clicking on its corresponding Taskbar button.  Also, Scrollbars 

are provided on the bottom and right sides of the Desktop. 
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Taskbar 

Scrollbars 
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4 RESPONSES 
 

4.1 Overview 
 

A response describes how a device transforms some input, represented by x, to an output, 

represented by y. 

 
For the case of a seismometer that measures ground displacement, the input to the seismometer is 

ground motion measured in nanometers and the seismometer output is an electric potential 

measured in volts.  So, the response, H, would have units of V/nm. 

 

The TALENT application can store responses in its database.  A user with administrative 

privileges will have to first setup the responses for other users to make use of.  However, once 

the responses are setup, then any users will be able to view them and apply them within tests. 

 

The purpose of including the responses within TALENT is to allow the user to take a waveform 

time series from a digitizer, measured in volts, and convert that voltage data to the original unit 

that was being measured by the device. 

 

4.2 Managing 
 

The responses stored within the database may be displayed by selecting the View → Responses 

menu item.  Any user may view and change the responses.  However, only an Administrator may 

save those changes to the database. 

H  x  y 
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The available responses are listed along the left-hand side of the dialog.  The responses are 

organized into folders based upon their input unit:  Displacement, Velocity, Acceleration, 

Pressure, and Voltage. 

 

Below the listed responses are several buttons for managing the responses: 

 

 Create a new response below the selected category folder. 

 Delete the selected response. 

 Duplicate the selected response. 

 Import one or more responses from a text file. 

 Export the selected response to a text file. 

 

The user may click on a response to display it within the response dialog.  
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At the top, the user may enter metadata about the response: 

 

Name The name used to label the response 

Description An arbitrary description of the response 

Date Date that the response was generated.  Note that this date is not 

necessarily the date that it was entered into the TALENT 

database. 

Gain The gain, or sensitivity, of the response at some nominal 

frequency. 

Frequency The frequency at which the gain is specified. 

Response 

Metadata 
Response List 

Response 

Specification 

Response 

Plot 



50  

Sample 

Rate 

The presumed sample rate used for displaying the gain and phase 

plots. 

Unit The unit of the response input.  Changing the unit will move the 

response to the appropriate folder within the list of responses. 

 

To the right of the metadata, the user may specify the response in one of several methods by 

selecting the desired method from the pull down menu: 

 

Pole/Zero The user may enter the analog Poles and Zeros within the tables 

below the pull down menu. 

FAP The user may enter Frequency-Amplitude-Phase (FAP) values 

within the table below the pull down menu. 

FIR The user may enter Finite-Impulse-Response (FIR) coefficients 

within the table below the pull down menu. 

 

Below the Metadata and Response Specification panes, there are several tabs that display 

information about the response that was entered.  Each of the tabs contains a chart of the relevant 

information.  The charts have several icons across the top: 

 

 

 Copy an image of the chart onto the clipboard. 

 Save an image of the chart to a file on disk. 

 Export the data in the chart as a text file on disk. 

 Enable panning on the chart.  Pan the chart display by dragging 

with the left mouse button. 

 
Enable zooming on the chart.  The user may zoom in by using the 

left mouse button to draw a box around the desired zoom region or 

a single click to zoom in a fixed amount.  The user may zoom out 

a fixed amount by clicking with the right mouse button. 

 
Configure the plot axes.  Use the dialog box, similar to the one 

shown below, to manually enter the axes limits. 
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Magnitude and Phase Response 

 

The magnitude and phase response plots display the amount of response gain in decibels and 

phase response in degrees versus frequency. 

 

 
 

Impulse Response 
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The impulse response plot displays the resulting output of the response if a single impulse were 

provided as input to the response. 

 

 
 

Pole/Zero 

 

The pole/zero plot displays the locations of the poles and zeros of the response. 
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4.3 Applying Responses 
 

Responses may be applied to the waveform time series within tests by selecting the desired 

response from within the Waveform Viewer.  Once the response is selected, the time series will 

be displayed in the input unit of the response instead of in Volts.  This conversion is a simple 

approximation made by dividing the time series in Volts by the response sensitivity at the 

calibration frequency (Volts/Input Unit) to obtain a time series.  See the section on the 

Waveform Viewer for additional details. 

 

If the test contains plots of Power Spectra versus frequency, then the selected waveform response 

will be used to perform frequency domain response removal in order to shape the power spectra. 
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5 MODELS 
 

5.1 Overview 
 

A model describes a simplified representation of some quantity that varies with frequency.  

Examples of possible models include site background noise, device self noise, threshold 

requirements, etc.  The purpose of including the models within TALENT is to allow the user to 

overlay the models on top of power spectra for comparison.  

 

5.2 Managing 
 

The models stored within the database may be displayed by selecting the View → Models menu 

item.  Any user may view and change the models.  However, only an Administrator may save 

those changes to the database. 

 

Model  

Metadata 
Model List 

Model 

Entry Table 

Model Plot 
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The available models are listed along the left-hand side of the dialog.  The models are organized 

into folders based upon their unit:  Displacement, Velocity, Acceleration, Pressure, and Voltage. 

 

Below the listed responses are several buttons for managing the responses: 

 

 Create a new model below the selected category folder. 

 Delete the selected model 

 Duplicate the selected model. 

 
Import one or more models from a text file. 

 

 
 

The model import dialog shown above allows the user to select one or more 

ASCII text files that contain model definitions.  The format must contain the 

model values in white space delimited columns with one row per frequency 

and value. 

 

There are a number of model import options displayed on the right hand side 

of the import dialog: 

 

Starting Line The first line of the file 

to start parsing.  All 

preceding lines will be 

skipped 

Comment The character used to 
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identify a comment 

line.  Any text on a 

comment line will be 

imported into the 

model description 

Frequency Column The column number, 

starting with 1, that 

contains the 

frequencies. 

Frequency Type Select whether the 

frequency is stored as 

frequency or period. 

Value Column The column number, 

starting with 1, that 

contains the values. 

Value Unit The unit of the values, 

selected from 

Displacement, 

Velocity, Acceleration, 

Pressure, or Voltage. 

 

 

 

 Export the selected model to a text file. 

 

The user may click on a model to display it within the model dialog. 
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At the top, the user may enter metadata about the model: 

 

Name The name used to label the model. 

Description An arbitrary description of the model. 

Date Date that the model was generated.  Note that this date is not 

necessarily the date that it was entered into the TALENT 

database. 

Unit The unit of the model data that the decibel gain values are relative 

to. 

 

To the right of the metadata, the user may specify the model by entering the frequency (Hz) and 

gain (decibel) values in the table.  Any values entered will automatically be sorted in order of 

increasing frequency.  

 

Below the Metadata and model entry panes, there is a chart displaying the model that has been 

entered.   The chart has several icons across the top: 

 

 Copy an image of the chart onto the clipboard. 
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 Save an image of the chart to a file on disk. 

 Export the data in the chart as a text file on disk. 

 Enable panning on the chart.  Pan the chart display by dragging 

with the left mouse button. 

 
Enable zooming on the chart.  The user may zoom in by using the 

left mouse button to draw a box around the desired zoom region or 

a single click to zoom in a fixed amount.  The user may zoom out 

a fixed amount by clicking with the right mouse button. 

 
Configure the plot axes.  Use the dialog box, similar to the one 

shown below, to manually enter the axes limits. 

 

 

 

5.3 Applying 
 

A model is applied within a test module simply by selecting it from a list within the PSD Viewer.  

The model will then be displayed within the PSD.  See the section on the PSD Viewer for 

additional detail. 

 

Note that for seismic applications including models specified in displacement, velocity, and 

acceleration, the models are dynamically transformed to the desired unit of ground motion. 
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6 COMPONENTS 
6.1 Overview 
 

Components within TALENT represent a single physical device that has some role in performing 

testing.  Components may represent a device under test, a portion of the Testbed, a portion of a 

System or Subsystem, or a dependency within a test. 

 

There are several types of components that are available within the application: 

 

 Digitizers 

 Seismic Sensor 

 Infrasound Sensor 

 Meter 

 Signal Generator 

 GPS Trigger 

 Isolation Chamber 

 Seismic Source 

 Infrasound Source 

 Temperature Sensor 

 Power Supply 

 Generic Testbed Sensor 

 

A component type is specified at the time of creation.  Once a component has been created, its 

type cannot be changed. 

 

6.2 Managing 
 

The specific metadata about a component may be displayed and changed by selecting the TOC 

entry representing the desired Component, right-click on the selected entry, and choosing 

Display from the context menu that appears. 

 

A viewer specific to the component will then appear within the application desktop.  All of the 

component viewers share a common layout and appearance.  However, some of the components 

have additional attributes that may be defined. 

 

The base Component Viewer is shown below: 
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The component metadata is contained within the upper portion of the component viewer: 

 

Name The name used to label the component. 

Type The type code stored in the database to identify the type of 

component 

Hardware A selection of hardware interfaces used for automated test 

command and control.  See the Command and Control section for 

a more detailed description. 

 

The Test button attempts to connect to the hardware interface.  A 

dialog is displayed to inform the user whether the connection 

failed or was successful. 

Response The associated response, if available, for this component. 

Testbed A flag indicating whether this component is a part of the Testbed.  

Components that are a part of the testbed are included within 

selection lists for component dependencies within the Test 

Viewers. 

Author Author who entered the component into the database. 

Date Date that the component was entered into the database in 

YYYY/MM/DD format. 

Description An arbitrary description of the component. 
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Below the metadata are the attributes that are defined for each type of component.  The attributes 

that all components share are: 

 

Manufacturer The name of the component manufacturer. 

Model Number The model of the component. 

Serial Number The serial number of the component. 

 

For those components that have additional attributes, a brief overview of each component is 

provided below. 

 

6.2.1 Digitizer 
 

 
 

Firmware 

Number 
The component firmware number 

Sample Rate The configured sample rate of the digitizer.  This sample rate 
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is used within the tests that are associated with this digitizer.  

For example, when controlling a Meter, the meter is 

automatically configured to sample at this rate. 

Peak to peak 

voltage 
The peak to peak voltage range. 

Number of 

Channels 

The number of channels that the digitizer can record.  There is 

a no maximum to the number of channels. 

Station Name The preferred station name for this digitizer. 

 

Below the specific digitizer attributes, there is a table of channel names and bitweight values.  

These bitweight values are the preferred bitweights for each of the digitizer channels.  It is 

expected that these bitweights would be either the manufacturer’s nominal bitweights or the 

experimentally derived bitweights from testing.   

 

The channel names and bitweights within the table will be used when a waveform time-series is 

loaded within a test that references this digitizer.  If the waveform time-series has a channel 

name that matches an entry in the table, then the corresponding bitweight will be automatically 

applied to the waveform. 

 

6.2.2 Seismic Sensor 
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Configuration The installation configuration of the sensor:  Vault or 

Borehole. 

Axes The axes configuration of the sensor:  Vertical, Horizontal, or 

3-Axis. 

Sensor Type The type of ground motion that the sensor outputs:  

Displacement, Velocity, or Acceleration 

Sensitivity The nominal sensitivity of the sensor 

Low Frequency The low frequency cutoff of the sensor’s bandpass.  

High Frequency The high frequency cutoff of the sensor’s bandpass. 

 

6.2.3 Infrasound Sensor 
 

 
 

Sensor Type The type of air motion that the sensor outputs:  Pressure. 

Sensitivity The nominal sensitivity of the sensor 

Low Frequency The low frequency cutoff of the sensor’s bandpass.  

High Frequency The high frequency cutoff of the sensor’s bandpass. 

 

 

6.2.4 Meter 
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Host Address The Host name or IP Address of the meter on the network 

Host Channel The channel number of the Meter. 

Channel 1 Name The preferred channel name for this meter.  

Channel 1 

Bitweight 

The preferred bitweight for this meter.  Note that most meters 

have a dynamic bitweight that changes depending its 

configuration.  Setting a preferred bitweight in this field may 

incorrectly override the bitweight coming from the meter. 

 

The Host Address and Host Channel attributes are intended to allow the Hardware interface to 

connect to the meter on an Ethernet network through an Ethernet to GPIB adapter.  The Host 

Address is the Ethernet address of the adapter.  The Host Channel is the GPIB Address of the 

meter.  Typically, if there is only a single GPIB device on the adapter, then the address will 

default to 22. 

 

6.2.5 Signal Generator 
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Host Address The Host name or IP Address of the function generator on the 

network 

Username The username for connecting to the function generator 

Password The password for connecting to the function generator 

 

6.2.6 Temperature Sensor 
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Host Address The Host name or IP Address of the temperature sensor 

Channel The channel number on the temperature sensor, if the device 

has multiple channels of temperature sensing. 
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7 SUBSYSTEMS 
7.1 Overview 
 

Subsystems within TALENT represent a collection of components that are intended to be 

operated together as a subsystem.   Typically, a subsystem includes a digitizer and one or more 

sensors:  seismic and/or infrasound.  The components that make up a subsystem are either 

created or linked using a shortcut within the subsystem folder.  The purpose of testing a 

subsystem is to test a specific digitizer and sensor pair together to determine if their performance 

is similar to the results from the component level testing. 

 

7.2 Managing 
 

The specific metadata for a subsystem may be displayed and changed by selecting the TOC entry 

representing the desired subsystem, right-click on the selected entry, and choosing Display from 

the context menu that appears. 

 

A subsystem viewer will then appear within the application desktop. 

 

 
 

Name The name used to label the subsystem. 

Author Author who entered the subsystem into the database. 

Date Date that the subsystem was entered into the database in 

YYYY/MM/DD format. 

Description An arbitrary description of the subsystem. 
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8 SYSTEMS  
8.1 Overview 
 

Systems within TALENT represent a collection of subsystems that are intended to be operated 

together.   Typically, a system includes multiple subsystems and some number of components.  

The components and subsystems that make up a system are either created or linked using a 

shortcut within the subsystem folder. 

 

8.2 Managing 
 

The specific metadata for a system may be displayed and changed by selecting the TOC entry 

representing the desired system, right-click on the selected entry, and choosing Display from the 

context menu that appears. 

 

A system viewer will then appear within the application desktop. 

 

 
 

Name The name used to label the system. 

Author Author who entered the system into the database. 

Date Date that the system was entered into the database in 

YYYY/MM/DD format. 

Description An arbitrary description of the system. 
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9 TEST PROCEDURES 
9.1 Overview 
 

The test procedures are an abstracted level above the test modules.  A test procedure defines a set 

of steps that must be performed in the course of a test.  Each step contains a description that 

includes written directions of what must be performed.  The procedure and its steps, along with a 

unique procedure type, are stored within the database.  A given test procedure is tied to a single 

test module.  However, there may be multiple procedures for a given test module. 

 

As an example: 

 

Test Procedure Test Module 

DC Accuracy DC Accuracy 

DC Full Scale DC Accuracy 

DC Over Scale DC Accuracy 

 

DC Accuracy, DC Full Scale, and DC Over Scale test procedures all use the DC Accuracy test 

module.  However, they have slightly different procedures directing the test operator to apply 

voltage levels that are within, at, or above the digitizer’s full scale range. 

 

Each procedure is specific to a System, Subsystem, or Component test.  In the case of 

Component tests, procedures are also specific to a particular type of Component (seismic sensor, 

digitizer, meter, etc).  The parameters and results of procedures may be subject to certain 

allowable ranges of values for a given test.  These requirements will be used to validate the 

results of a test. 

 

Only an Administrator may make changes to the test procedures stored in the database. 

 

9.2 Managing 
 

The test procedures stored within the database may be displayed by selecting the Admin → 

Procedure Editor menu item.  Only an Administrator has access to the procedure editor. 

 

The Procedure Editor will appear within the TALENT Desktop as shown below. 
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The Procedure Editor is comprised of a desktop and a table of contents.  The procedure 

desktop, similar to the TALENT desktop, is where the viewers related to the procedures are 

displayed.  The procedure table of contents contains entries for each of the component types, 

subsystems, and systems for which there are test modules.   

 

The top level entries within the table of contents are the components, subsystems, and systems 

for which test procedures may be created.  Below each top level entry are the test procedures.  

The administrator may arrange the order of these procedures however they may like.  Below 

each procedure are the ordered steps for that procedure.   

 

Procedure 

Desktop 

Procedure  

Table of Contents 
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Select an entry in the table of contents and right-click with the mouse to display the context 

menu shown below: 
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Display Display the appropriate viewer within the desktop for 

the selected procedure or step. 

 

The user may also perform this action by double-

clicking the TOC entry with the left mouse button. 

Rename Change the name of the selected procedure or step. 

New 

Procedure 

Create a new procedure below the selected component, 

subsystem, or system.  The menu of available 

procedures is dynamic depending upon the selected 

entry in the table of contents.  

New Step Create a new Step below the selected procedure.  

Copy Copy the selected TOC entries onto the clipboard. 

Paste Paste the entries on the clipboard within the selected 

TOC entry. 

Delete Delete the selected procedures and steps. The user will 
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be prompted to confirm the deletion: 

 

 

 

 

In addition to the context menu, the Administrator may also rearrange procedures and step using 

the drag and drop mouse operation.  Procedures may not be dragged or copied to other devices 

under test as they are only valid for the device under which they were created.  Steps, however, 

may be dragged or copied to any procedure without restriction. 

 

9.3 Editing a Procedure 
 

The specific metadata for a procedure may be displayed and changed by selecting the TOC entry 

representing the desired procedure, right-click on the selected entry, and choosing Display from 

the context menu that appears. 

 

A procedure viewer will then appear within the application desktop. 

 

 
 

Name The name used to label the procedure. 

Test Type Unique identifier for the test module that this procedure is for.  
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The Test Type cannot be modified.  

Procedure 

Type 

Unique Procedure identifier that is used to track this procedure.  

The Administrator is responsible for determining an appropriate 

identification code to be used. 

Description A description of the procedure 

 

9.4 Editing a Step 
 

The specific metadata for a step may be displayed and changed by selecting the TOC entry 

representing the desired step, right-click on the selected entry, and choosing Display from the 

context menu that appears. 

 

A step viewer will then appear within the application desktop. 

 

 
 

Name The name used to label the step. 

Description A description of the procedure 
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10 TEST PLAN 
10.1 Overview 
 

A test plan contains an organized set of tests that are to be applied to a given component, 

subsystem, or system.  A test plan contains multiple test cases that are organized within a folder 

hierarchy.  A given component may have multiple test plans to provide multiple levels of testing 

(research, qualification, production, etc). 

 

The purpose of a test plan is to define a template of tests that can be instantiated at once.  The 

test plan definition can include a hierarchy of test cases. 

 

Only an Administrator may make changes to the test plans stored in the database 

 

10.2 Test Case 
 

A test case is a specific implementation of a test procedure within a test plan.  A given test case 

is tied to a single test procedure.  However, there may be multiple test cases for a given test 

procedure.  Each test case defines the initial parameter values for a test module.  These parameter 

values are an indication to the test operator what the operating conditions of the test are.  In 

addition, a test case defines the pass criteria, expressed as a minimum and maximum value, that 

determine whether the results of a test module are acceptable. 

 

10.3 Managing 
 

The test procedures stored within the database may be displayed by selecting the Admin → Test 

Plan Editor menu item.  Only an Administrator has access to the procedure editor. 

 

The Test Plan Editor will appear within the TALENT Desktop as shown below. 
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The Test Plan Editor is comprised of a desktop and a table of contents.  The test plan desktop, 

similar to the TALENT desktop, is where the viewers related to the test plans are displayed.  The 

test plan table of contents contains entries for each of the component types, subsystems, and 

systems for which there are test modules.   

 

The top level entries within the table of contents are the components, subsystems, and systems 

for which test procedures may be created.  Below each top level entry are the test procedures.  

The administrator may arrange the order of these procedures however they may like.  Below 

each procedure are the ordered steps for that procedure.   

 

Select an entry in the table of contents and right-click with the mouse to display the context 

menu shown below: 

Test Plan 

Desktop 

Test Plan 

Table of Contents 
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Display Display the appropriate viewer within the desktop for 

the selected test plan or test case. 

 

The user may also perform this action by double-

clicking the TOC entry with the left mouse button. 

Rename Change the name of the selected folder, test plan, or 

test case. 

New 

folder 

Create a new folder below the selected entry. 

New 

test 

plan 

Create a new test plan below the selected component, 

subsystem, or system.  

New 

test 

case 

Create a new test case below the selected entry.  The 

available list of menu entries when creating a new test 

case changes depending upon the component, 

subsystem, or system that the test plan falls under. 

 

Test cases can only be created for test modules which 

have defined procedures. 

Copy Copy the selected TOC entries onto the clipboard. 

Paste Paste the entries on the clipboard within the selected 

TOC entry. 
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Delete Delete the selected TOC entries. The user will be 

prompted to confirm the deletion: 

 

 

 

 

In addition to the context menu, the Administrator may also rearrange folders and test cases 

using the drag and drop mouse operation.  Test plans and test cases may not be moved or copied 

to other devices under test as they are only valid for the device under which they were created.  

However, test cases may be moved or copied to other test plans within the same device under 

test. 

  

10.4 Editing a Test Plan 
 

The specific metadata for a test plan may be displayed and changed by selecting the TOC entry 

representing the desired procedure, right-click on the selected entry, and choosing Display from 

the context menu that appears. 

 

A test plan viewer will then appear within the application desktop. 

 

 
 

Name The name used to label the test plan. 

Description A description of the procedure 
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10.5 Editing a Test Case 
 

The specific metadata for a test case may be displayed and changed by selecting the TOC entry 

representing the desired test case, right-click on the selected entry, and choosing Display from 

the context menu that appears. 

 

A test case viewer will then appear within the application desktop. 
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Name The name used to label the step. 

Procedure 

Type 

The unique procedure identifier used to tie the test case to a 

procedure. 

 

The Procedure Type is displayed for informational purposes only 

and cannot be modified. 

Description A description of the procedure 

 

The Default Parameter Values pane contains a table of the initial default values for this test 

case.  The administrator may customize any of these values.  When the test plan is implemented 

and tests are created for each of the defined test cases, the test parameters will be set to these 

initial default values.  The set of parameters is unique to each test module.  However, the 

parameters generally include things such as filter definitions, waveform time segments, power 

spectra parameters, etc. 

 

The Result Criteria Values pane contains a table of the acceptable result values for this test.  

The administrator may customize any of these values by specifying a range of minimum and 

maximum acceptable values.  For any test that is created from this test case definition, when the 

test results are computed, any values that fall outside of this acceptable range will be flagged as 

being outside of the acceptable range. 
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11 TEST VIEWERS 
11.1 Overview 
 

Each of the test modules within the TALENT application has a unique viewer associated with it 

that will allow the user to display and make changes to a test.  The test viewers are customized 

for each test module to support the unique set of waveforms, parameters, and results that make 

up a test module.  Also, the test viewers enforce any rules that are specific to the test such as 

ensuring that there are sufficient waveforms or that the time segments are all of the same lengths. 

 

This manual will not attempt to cover every test viewer that has been developed.  However, all of 

the test viewers have been designed to share a common look and to make use of similar 

components.  These components and the general behaviors will be explained so that the user 

should be able to comfortably make use of any of the test viewers. 

 

The general template for the Test Viewers is to have the test module name at the top of the 

window along with a number of panels that flow from the top of the window down to the bottom.  

These panels can include a Test Metadata section for entering common attributes about the test, 

a Waveform section for loading and selecting portions of the waveform data to be used in the 

test, a Power Spectral Density section for displaying the power spectra of any selected 

waveform data, a section for Parameters & Results, and Control buttons.  Additional details on 

each of these panels can be found in the subsequent sections. 

 

Many of these panels also support the ability to be expanded and collapsed by clicking on the 

green arrow in the upper right hand corner of the panel.    Since the test viewers can become very 

large depending upon the number of waveforms that have been loaded, shrinking some of the 

panels allows the user to focus on just the sections of the test viewer that they are interested in at 

a given time.  



86  

 
 

 

11.2 Test Metadata 
 

The Test Metadata panel contains general attributes about a test.  These attributes are common to 

all tests.  This panel is present within all Test Viewers.  The Test Metadata panel is always 

collapsed when the test viewer first appears.  The user may toggle the panel between being 

collapsed and expanded by clicking on the green arrow in the upper right hand corner of the 

panel.  The panel appears as shown below: 

 

 

 
 

Metadata 

Waveforms 

Power 

Spectral 

Density 

Parameters 

&  

Results 

Control 

Buttons 
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Name The name used to label this test. 

Temperature The ambient temperature at the time 

Created The name of the user and the date on which this test was created. 

Executed A checkbox allowing a user to indicate that the test has been 

performed.  If the test has been executed, then the current user 

name and date will inserted to stamp the test execution.  Also, the 

flag indicator for this test within the TALENT Table of Contents 

will change from red to yellow. 

Reviewed A checkbox allowing a user to indicate that the test has been 

reviewed for quality assurance.  This checkbox is not enabled 

until the test has been executed.  If the test has been reviewed, 

then the current user name and date will be inserted to stamp the 

test review.  Also, the flag indicator for this test within the 

TALENT Table of Contents will change from yellow to green. 

 

Once a test has been flagged as having been reviewed, all of the 

interface controls within the test viewer that would allow a user to 

make modifications to the test are disabled.  This prevents a user 

from inadvertently modifying a test once it has been reviewed. 

Temperature 

Sensor 

Select the temperature sensor from the pull down menu of 

available Testbed components.  The sensor will be used to directly 

acquire the ambient temperature when the test is run. 

 

Additional component dependencies may be available within the 

Metadata panel depending upon the specific test.  These 

associations are captured in the database and used to provide 

traceability as well as for command and control when tests are 

run. 

Description A description of the test 

 

11.2.1 Procedure Viewer 
 

The Test Metadata panel may also include the Test Procedure steps.  This portion of the Test 

Metadata panel is only visible if the test was created from a previously established Test Plan with 

a defined Test Procedure.  The Test Procedure steps are displayed as shown below: 
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The step number, name, and description are shown.  The user may cycle between the steps using 

the Previous and Next buttons.  The current step is stored within the database so that if the user 

closes the test viewer or the TALENT application, when the Test Viewer resumes at the step at 

which the user had left off. 

 

11.3 Waveform Viewer 
 

The Waveform Viewer provides the user with the ability to load, manage, and select the 

waveforms that are to be used in a test.  Most Tests Viewers contain a single Waveform Viewer 

that can contain one or more waveforms.  However, some tests have two Waveforms Viewers.  

Having multiple Waveform Viewers allows a test to differentiate between the waveform based 

upon their use.  Typically, the first Waveform Viewer will contain a single reference waveform 

(from a meter in the case of a digitizer test or a reference sensor in the case of a sensor test) and 

the second Waveform Viewer will contain the test waveforms. 

 

 
 

Across the top of the Waveform Viewer are several icons related to managing the waveform time 

series: 

 

 
Load waveforms from one or more external files.  Once the 

waveforms have been loaded into the test, the waveforms 

will be stored in the database and the external files will no 

longer be needed by the TALENT application. 

 
Save the waveforms to an external file.  This external file is 

separate and distinct from the waveforms stored within the 

TALENT database.  This functionality is only provided to 

allow for sharing waveform data between applications or 

users outside of the TALENT application. 
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 Copy an image of the Waveform Viewer onto the clipboard. 

 Save an image of the Waveform Viewer to a file on disk. 

 

Synchronize the X and/or Y Axes for all of the waveforms 

within the Waveform Viewer.  With the axes synchronized, 

any changes made to zooming or panning of one waveform 

will be automatically reflected in the other waveforms. 

 

Apply, Remove, or Edit the time-domain filter for the 

waveforms within the Waveform Viewer. 

 

Details on the Edit filter dialog are covered in section 

3.1.2.3 Filters. 

 

 Display a sine fit overlaid on the waveform time series.  The 

sine time series is displayed in green and the error is 

displayed in red.  Note that this button is only enabled for 

those tests that perform sine fits in their analysis.  For all 

other tests, this button is disabled. 

 Enable panning on the chart.  Pan the chart display by 

dragging with the left mouse button. 

 
Enable zooming on the chart.  The user may zoom in by 

using the left mouse button to draw a box around the desired 

zoom region or a single click to zoom in a fixed amount.  

The user may zoom out by clicking with the right mouse 

button. 

 
Enable waveform cutting on the chart.  Cut a waveform by 

dragging a selection box on the desired waveform.  Any 

portion of the waveform outside the time bounds of the 

selection box will be discarded.  Warning, a waveform cut 

cannot be undone.  To recover a waveform, the waveform 

must be reloaded from an external data file or the test 

reloaded from the database. 

 
Enable the waveform time segment.  A user may set a 

waveform time segment by dragging a segment with the left 

mouse button.  An existing time segment may be moved by 

dragging on the middle portion of the segment or resized by 

dragging on either side of the segment.  Note that some Test 

Viewers impose restrictions on position or duration of the 

time segments. 

 

The Waveform Viewers in a particular test may contain 

additional time segment controls in order to select multiple 
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portions of the waveforms. 

 

 

There are additional buttons and controls to the right of the waveform plot: 

 

 
 

 

 Delete this waveform from the Waveform Viewer 

Station Display and/or modify the waveform station name 

Channel Display and/or modify the waveform channel name 

Samplerate Display the waveform sample rate in Hertz. 

Bitweight Display and/or modify the waveform bitweight in units of 

volts/count. 

 

In addition to reading and writing waveforms from within the Waveform Viewer, waveforms can 

also be transferred between Waveform Viewers via a drag and drop operation.  If the source 

Waveform Viewer contains only a single waveform, then a copy of that waveform will be added 

to the target Waveform Viewer.  If the source Waveform Viewer contains multiple waveforms, 

then the user will be presented with a selection dialog allowing them to indicate which of the 

waveforms are to be copied, as shown in the figure below. 
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11.3.1 Responses 
 

In the case of tests that are related to sensors, the Waveform Viewer contains two additional 

controls as shown below:  Response and Unit 

 

 
 

The user may select an instrument response from the Response pull down list.  The list of 

available responses is populated from the responses stored in the database.  If the test is for a 

seismic sensor, then the responses include displacement, velocity, and acceleration responses.  If 

the test is for an infrasound sensor, then the responses include only pressure responses.  Once 

selected, the response is associated with the waveform and is used to convert the waveform time 

series from a voltage to the appropriate earth unit. 

 

For the case of seismic responses, the user may select a unit from the Unit pull down list.  The 

selected unit defaults to the unit of the selected response:  displacement, velocity, or acceleration.  

However, the user may override that selection and the waveform time series being displayed will 

be automatically integrated, differentiated, and/or scaled as necessary to perform the conversion. 

 

11.3.2 Read Waveforms 
 

The user may read waveform data from files on disk by clicking on the Load Waveforms icon in 

the Waveform Viewer.  The dialog for reading waveforms will appear similar to the one shown 

below.  The user may select one or more files that contain waveform time series data from the 

main file browser dialog.  The following waveform formats are supported for reading: 

 

ASCII integer counts with one value per line and a header in the format of:   

“H <epoch seconds> <channel> <sample rate> <bitweight>” 

CD1.1 

CSS Flatfile 

Geotech Smart24 binary 

Guralp GCF 

MiniSEED 

RefTek 

SAC 
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Once the user has selected one or more files, the panel to the right is updated to display the 

available channels of waveform data.  The user simply needs to select the checkbox next to the 

waveform table entries that they wish to read.  The fields in the Bitweight column of the table 

are editable if the user wishes to override the bitweight contained within the file. 

 

The Single channel checkbox, if selected, directs the application to treat all of the waveform 

data being read as if it were from a single channel regardless of the designated station and 

channel name within the file.  All of the waveform data will then be merged into a single 

waveform time series.  This option is useful if the waveform data to be read in does not have a 

consistent station and channel naming convention. 

 

The Concatenate segments checkbox, if selected, directs the application to not honor the time 

stamps on the waveform segments being read in.  Instead, the waveform segments will simply be 

concatenated without any regard to their absolute timing.  This option is useful if there are 

significant time errors in the data being read in or if the user desires to read in several short time 

segments that have a significant gap of time between them. 

 

The Merge with existing waveforms checkbox, if selected, directs the application to combine 

the waveform segments being read in with any existing waveforms already in the Waveform 

Viewer.  This option is useful if the user wishes to add additional data to existing waveforms.  It 

may be necessary to use this option, for example, if there are several waveform data files that 

span multiple directories. 

 

The Fill gaps checkbox, if selected, directs the application to fill any data gaps with the average 

of the values just before and after each gap.  If this option is not selected, then any data gaps will 

be filled with zeros. 
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The start and end time default to the range for which there is available data.  The user may 

optionally reduce the time range to down-select the amount of data to be read in.  The start and 

end time are specified as Year/Month/Day Hour:Minute:Second.Millisecond. 

 

11.3.3 Write Waveforms 
 

The user may write waveform data to files on disk by clicking on the Save Waveforms icon in 

the Waveform Viewer.  The dialog for writing waveforms will appear similar to the one shown 

below: 

 

 
 

The user may select the file to be written to from the main file browser dialog.  On the panel to 

the right, the user may selected the waveform within the Waveform Viewer that are to be written 

as well as the data format from the pulldown menu: 
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11.4 Power Spectral Density Viewer 
 

The Power Spectral Density (PSD) Viewer displays the power spectra of the selected waveform 

segments from the Waveform Viewer. 

 

 
 

At the top of the PSD Viewer is a toolbar with buttons for interacting with the Viewer: 

 

 Copy an image of the chart onto the clipboard. 

 Save an image of the chart to a file on disk. 

 Export the data in the chart as a text file on disk. 

 Enable panning on the chart.  Pan the chart display by dragging 

with the left mouse button. 

 
Enable zooming on the chart.  The user may zoom in by using the 

left mouse button to draw a box around the desired zoom region or 

a single click to zoom in a fixed amount.  The user may zoom out 

amount by clicking with the right mouse button. 

 
Configure the plot axes.  Use the dialog box, similar to the one 

shown below, to manually enter the axes limits. 
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Select the PSD visibility for each of the waveforms that are being 

displayed. 

 Select the Models to overlay on the PSD Viewer 

 
Toggle the visibility of any markers that have been overlaid on the 

PSD. 

 

Below the PSD Toolbar are several controls for configuring how the power spectra are 

computed: 

 

DC Removal Specifies how the DC average of the waveform time series 

is removed from each window of data prior to computing 

the FFT and Power Spectra.  The available options are:  

None, the average of the entire time series, and the average 

of the window. 

Window Specifies the windowing function that is used to shape each 

window of data.  The available options are:  Rectangular, 

Hann, Hamming, Kaiser Bessell, and Bartlett. 

FFT Length Specifies the length of the FFT (and Window) that are used 

in computing the PSD.  The available options are:  128, 256, 

512, 1024, 2048, 4096, 8192, 16K, 32K, 64K, 128K, and 

256K.  The large the FFT length, the finer frequency 

resolution in the PSD. 

FFT Overlap Specifies how much the subsequent windows overlap each 

other as a fraction of their length.  The available options are:  

0, 1/8, 1/4, 3/8, 1/2, 5/8, 3/4, and 7/8.  Overlapping the 

windows allows for a somewhat improved confidence 

interval without having to collect additional data. 
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90% Confidence 

Interval 

The range, in decibels, that there is a 90% confidence that 

the estimated power spectra agrees with the underlying 

spectral content of the data.  This range decreases as the 

amount of data being analyzed increases. 

Unit The unit in which the PSD data will be displayed.  This 

parameter is only useable for seismic data.  The user can 

select between displacement, acceleration, and velocity. 

 

11.5 Parameters 
 

Test Modules contain a variety of parameters that are unique to each test.  The majority of these 

parameters are integrated into the existing panels within the Test Viewer.  However, for those 

parameters that are not otherwise addressed, individual text fields and selection boxes are 

incorporated into the Test Viewer. 

 

11.6 Results 
 

Test Modules contain a variety of results that are unique to each test.  The results for a given test 

will be displayed in a combination of non-editable text fields, tables of result values, and plots. 

 

 If there is a single result value that is generated, then that value will be displayed within a non-

editable text field.  However, it is more often the case that there are several computed values for 

multiple waveforms.  In this case, the results are presented within a table, such as the one shown 

below for an Input Terminated Noise test: 

 

 
 

The results for each waveform are contained within a single row.  The first column identifies the 

waveform for the row.  For the remaining columns, some tests have a fixed definition of the 

results that are computed; however, other tests have a user defined set of columns.  For the tests 

with variable columns, the user can typically add/delete columns and double-click on the column 

header to edit the value. 

 

The result tables also support drag and drop of the table content.  The column names are 

automatically included in the drop operation. 

 

11.7 Control Buttons 
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There are several control buttons at the bottom of each of the Test Viewers: 

 

 Refresh the Test Viewer.  A viewer refresh may be 

necessary if the user has made any changes to the 

application outside of the test viewer such as modifying the 

display properties, responses, models, testbed components, 

or the device under test.  All unsaved changes within the test 

will be lost when the viewer is refreshed. 

Run Run the test by connecting to any of the associated hardware 

components that support command and control.  This 

capability automates some of the signal generation and 

acquisition. 

Compute Compute the test results based upon the waveforms and 

parameters within the test.  Note that the computed results 

are not automatically saved to the database. 

Apply Save the waveforms, parameters, and results to the database. 

Close Close the Test Viewer.  If the user has not saved any 

changes made to the database, they will be presented with a 

confirmation dialog:  

 

 
 

 Save the current test parameters as defaults.  The next time 

that a test of this type is created, its parameters will be set to 

these default values.  The test parameter defaults are stored 

in the same talent.properties file that the TALENT 

application properties are stored. 
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12 TEST MODULES 
 

At the most fundamental level within the TALENT application is the test modules.  The test 

modules are defined statically within the software application.  Each test modules has a unique 

set of parameters, results, and waveforms that are captured within the database.  In addition, each 

test module has a custom user interface to allow the user to interact with the test module.  Each 

test module that has been defined applies only to a specific set of component types, subsystems, 

or system.  

 

Below is a brief description of the tests, as well as some general directions for using the modules.  

For a more in-depth description of the test setup and how results are computed, see the 

appropriate reference section for that test (Kromer, 2007; Merchant, 2011) 
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12.1 General Test 
 

12.1.1 Power Consumption Test 
 

The Power Consumption Test is used to measure the amount of power that an actively powered 

electrical component consumes during its operation.   
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Procedure: 

 

1. Select the desired Temperature Sensor and Meter Testbed components that are to be 

used in this test from within the appropriate pull-down list in the Test Metadata section. 

2. Enter the Resistance Value, Number of samples, Supply Voltage, and Supply Voltage 

SD parameters.  The resistance value is used to measure the current through a resistor.  

The specified number of samples and the waveform sample rate determine the length of 

the waveform time segment that may be selected.  Changing either of these parameters 

will automatically update the time segment length.  The supply voltage and its standard 

deviation are obtained from the power supply settings. 

3. (Optional) Using the power supply and meter, record a reference waveform.  Load that 

reference waveform into the Reference Waveform Viewer and select the desired 

waveform time segment to be used.  If a reference waveform is present, then upon 

compute the Supply Voltage and Supply Voltage SD parameter will be updated with the 

computed average voltage of the selected reference waveform time segment.  Otherwise, 

if no reference waveform is present, then the Supply Voltage and Supply Voltage SD 

parameters will simply be used as specified. 

4. Connect the meter to the current sensing resistor and record a segment of data while the 

device is powered.  Once the data has been recorded, load the waveform into the 

Waveform Viewer.  Select the desired waveform time segments for the signal.  The 

waveform time segments may be set independently of one another.  However, their 

lengths are all fixed to be the same. 

5. Click the Compute button at the bottom of the test window.  The results of the analysis 

will appear in the table below the waveforms. 

6. Click the Apply button at the bottom of the test window.  The entirety of the test will be 

saved to the database. 
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12.2 Digitizer Tests 
 

12.2.1 AC Accuracy Test 
 

The AC Accuracy Test is used to measure the DC offset and bitweight of a digitizer channel by 

recording a sinusoid with known frequency and amplitude. 
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Procedure: 

 

1. Select the desired Temperature Sensor, Sine Generator, and Meter Testbed 

components that are to be used in this test from within the appropriate pull-down list in 

the Test Metadata section. 

2. Enter the Number of cycles for sine-fit, Calibration Voltage, and Calibration 

Frequency parameters.  The specified number of cycles and the calibration frequency 

determine the length of the waveform time segment that may be selected.  Changing 

either of these parameters will automatically update the time segment length. 

3. (Optional) Using the signal generator and meter, record a reference waveform.  Load that 

reference waveform into the Reference Waveform Viewer and select the desired 

waveform time segment to be used.  If a reference waveform is present, then upon 

compute the Calibration Voltage parameter will be updated with the computed peak 

voltage of the selected reference waveform time segment.  Otherwise, if no reference 

waveform is present, then the Calibration Voltage parameter will simply be used as 

specified. 

4. Record the signal generator output on each of the desired digitizer channels.  Load the 

waveform for each of the channels into Test Waveform(s) Waveform Viewer and select 

the desired waveform time segment to be used for each waveform.  The waveform time 

segments may be set independently of one another.  However, their lengths are all fixed 

to be the same. 

5. Click the Compute button at the bottom of the test window.  The results of the analysis 

will appear in the table below the waveforms.  

6. Click the Apply button at the bottom of the test window.  The entirety of the test will be 

saved to the database. 
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12.2.2 AC Clip Test 
 

The AC Clip Test measures the digitizer clip level and behavior by feeding a sinusoid signal into 

a channel of the digitizer.  When the digitizer input exceeds the maximum allowable input, the 

digitizer “clips” the waveform, and becomes flat at the peak and trough of the sine wave.  This 

parameter is an important one to know in testing because clipping the digitizer for a prolonged 

period of time may cause permanent damage to the digitizer. 

 

 
 

Procedure: 

 

1. Select the desired Temperature Sensor and Sine Generator Testbed components that 

are to be used in this test from within the appropriate pull-down list in the Test Metadata 

section. 
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2. Enter the Number of samples in windows, Peak input voltage, and Frequency 

parameters.  The specified number of samples and the waveform sample rate determine 

the length of the waveform time segment that may be selected.  Changing either of these 

parameters will automatically update the time segment length. 

3. Connect the signal generator to each of the digitizer channels and obtain clipped data by 

slowly increasing the amplitude of the signal generator.  Once the data has been recorded, 

disconnect the signal generator immediately and load the waveform into the Waveform 

Viewer.  Select the desired waveform time segments for the positive (green) and negative 

(red) portions of the clipped sinusoid.  The test module will attempt to select these 

regions automatically; however, the user may need to refine those selections.  The 

waveform time segments may be set independently of one another.  However, their 

lengths are all fixed to be the same. 

4. Click the Compute button at the bottom of the test window.  The results of the analysis 

will appear in the table below the waveforms. If the digitizer passed the expected clip 

behavior, then the user may check the Test Passed checkbox. 

5. Click the Apply button at the bottom of the test window.  The entirety of the test will be 

saved to the database. 
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12.2.3 Analog Bandwidth Test 
 

The Analog Bandwidth Test measures the frequency bandwidth by feeding white noise from a 

signal generator into one or more of the digitizer channels. 
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Procedure: 

 

1. Select the desired Temperature Sensor and White Noise Generator Testbed 

components that are to be used in this test from within the appropriate pull-down list in 

the Test Metadata section. 

2. Enter the Number of averaging bins, Time Segment Length, White Noise Amplitude, 

and White Noise Bandwidth parameters.  The number of averaging bins specifies how 

the PSD will be smoothed.  The time segment length specifies the length of the selected 

waveform time segment.  The white noise amplitude and bandwidth capture the 

characteristics of the signal that is fed into the digitizer channels. 

3. Record the signal generator output on each of the desired digitizer channels.  Load the 

waveform for each of the channels into Test Waveform(s) Waveform Viewer and select 

the desired waveform time segment to be used for each waveform.  The waveform time 

segments are fixed across all of the digitizer channels. 

4. Click the Compute button at the bottom of the test window.  The results of the analysis 

will appear in the table below the waveforms.  

5. Click the Apply button at the bottom of the test window.  The entirety of the test will be 

saved to the database. 
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12.2.4 Common Mode Rejection Test 
 

The Common Mode Rejection Test measures the ability of a digitizer to reject a common mode 

signal on a differential input channel.  For this test, a signal generator is used to generate a 

sinusoid with known frequency and amplitude and this signal is applied to both of the differential 

input lines. 
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Procedure: 

 

1. Select the desired Temperature Sensor and Sine Generator Testbed components that 

are to be used in this test from within the appropriate pull-down list in the Test Metadata 

section. 

2. Enter the Reference Amplitude, Reference Frequency, and Number of cycles for sine-

fit parameters.  The reference amplitude and frequency describe the sinusoid signal that 

the signal generator is set to output.  The number of sinusoid cycles specifies the length 

of the selected waveform time segment. 

3. Record the signal generator output on each of the desired digitizer channels.  Load the 

waveform for each of the channels into Waveform Viewer and select the desired 

waveform time segment to be used for each waveform.  The waveform time segments are 

independent across all of the digitizer channels. 

4. Click the Compute button at the bottom of the test window.  The results of the analysis 

will appear in the table below the waveforms.  

5. Click the Apply button at the bottom of the test window.  The entirety of the test will be 

saved to the database. 
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12.2.5 Crosstalk Test 
 

The Crosstalk Test measures how much of a signal recorded on one channel of a digitizer is also 

present on another channel as noise.  For this test, a signal generator is used to generate a 

sinusoid with known frequency and amplitude.  One digitizer channel will be input terminated 

and the remaining channels will be connected to the signal generator. 
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Procedure: 

 

1. Select the desired Temperature Sensor and Sine Generator Testbed components that 

are to be used in this test from within the appropriate pull-down list in the Test Metadata 

section. 

2. Enter the Time Segment Length, Signal Voltage, Signal Frequency, and Input 

Terminated Resistance parameters.  The time segment length specifies the length of the 

waveform time segment.  The signal voltage and frequency describe the sinusoid signal 

that the signal generator is set to output.  The input terminated resistance specifies the 

value of the resistor that was used to terminate one of the digitizer channels. 

3.  Record the terminated digitizer channel and the tonal signal channels.  Load the 

terminated waveform into the Input Terminated Waveform Viewer.  Load the tonal 

waveforms into the Tonal Waveforms Viewer.  Select the desired waveform time 

segment to be used for each of the waveforms.  The waveform time segments are fixed to 

be identical. 

4. If necessary, adjust the PSD options to better resolve the peak of the sinusoidal tone:  DC 

Removal, Window type, FFT Length, and FFT Overlap. 

5. Click the Compute button at the bottom of the test window.  The results of the analysis 

will appear in the table below the waveforms. The results should show crosstalk between 

the input terminated channel and each of the tonal channel.  In addition, a mean crosstalk 

will be computed. 

6. Click the Apply button at the bottom of the test window.  The entirety of the test will be 

saved to the database. 
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12.2.6 DC Accuracy Test 
 

The DC Accuracy Test is used to measure the DC offset and bitweight of a digitizer channel by 

recording a known positive and negative DC signal at a reference voltage from a precision 

voltage source. 
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Procedure: 

 

1. Select the desired Temperature Sensor, DC Source Generator, and Meter Testbed 

components that are to be used in this test from within the appropriate pull-down list in 

the Test Metadata section. 

2. Enter the Number of samples and Calibration Voltage parameters.  The specified 

number of samples and the waveform sample rate determine the length of the waveform 

time segment that may be selected.  Changing either of these parameters will 

automatically update the time segment length.  The Calibration Voltage is the amplitude 

of the DC signal that is being used.  

3. (Optional) Using the signal generator and meter, record a reference waveform.  Load that 

reference waveform into the Reference Waveform Viewer and select the desired 

waveform time segment to be used.  If a reference waveform is present, then upon 

compute the Calibration Voltage parameter will be updated with the computed average 

voltage of the selected reference waveform time segment.  Otherwise, if no reference 

waveform is present, then the Calibration Voltage parameter will simply be used as 

specified. 

4. Connect the signal generator to each of the digitizer channels and obtain DC Accuracy 

data by recording positive and negative segments of data.  Once the data has been 

recorded, load the waveform into the Waveform Viewer.  Select the desired waveform 

time segments for the positive (green) and negative (red) portions of the DC signal.  The 

test module will attempt to select these regions automatically; however, the user may 

need to refine those selections.  The waveform time segments may be set independently 

of one another.  However, their lengths are all fixed to be the same. 

5. Click the Compute button at the bottom of the test window.  The results of the analysis 

will appear in the table below the waveforms. 

6. Click the Apply button at the bottom of the test window.  The entirety of the test will be 

saved to the database. 
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12.2.7 Input Impedance Test 
 

The Input Impedance Test measures the input impedance of a digitizer channel.  A meter is 

configured to measure impedance and is connected to the digitizers input channel. 

 

 
 

 

 



115  

 

Procedure: 

 

1. Select the desired Temperature Sensor and Meter Testbed components that are to be 

used in this test from within the appropriate pull-down list in the Test Metadata section. 

2. Enter the Time Segment Length parameter.  The time segment length specifies the 

length of the waveform time segment.   

3. Record the input impedance for each of the desired digitizer channels.  Load the 

waveform for each of the channels into Waveform Viewer and select the desired 

waveform time segment to be used for each waveform.  The waveform time segments are 

independent across all of the digitizer channels. 

4. Click the Compute button at the bottom of the test window.  The results of the analysis 

will appear in the table below the waveforms.  

5. Click the Apply button at the bottom of the test window.  The entirety of the test will be 

saved to the database. 
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12.2.8 Input Shorted Offset Test 
 

The Input Shorted Offset Test measures the amount of DC offset present on a digitizer by 

collecting waveform data from an input channel that has been shorted.  Thus, any signal present 

on the recorded waveform should be solely due to any internal offset of the digitizer. 

 

 
 

 

Procedure: 
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1. Select the desired Temperature Sensor Testbed component that is to be used in this test 

from within the appropriate pull-down list in the Test Metadata section. 

2. Enter the Time Segment Length parameter.  The time segment length specifies the 

length of the waveform time segment.   

3. Record the waveform data for each of the desired digitizers whose inputs are shorted.  

Load the waveform for each of the channels into Waveform Viewer and select the 

desired waveform time segment to be used for each waveform.  The waveform time 

segments are independent across all of the digitizer channels. 

4. Click the Compute button at the bottom of the test window.  The results of the analysis 

will appear in the table below the waveforms.  

5. Click the Apply button at the bottom of the test window.  The entirety of the test will be 

saved to the database. 
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12.2.9 Input Terminated Noise Test and Maximum Potential Dynamic Range Test 
 

The Input Terminated Noise Test and Maximum Potential Dynamic Range measures the amount 

of zero state noise present on a digitizer by collecting waveform data from an input channel that 

has been terminated with a resistor. 
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Procedure: 

 

1. Select the desired Temperature Sensor Testbed component that is to be used in this test 

from within the appropriate pull-down list in the Test Metadata section. 

2. Enter the Time Segment Length, Resistance, Nominal Bitweight, and Number of bits 

parameters.  The time segment length specifies the length of the waveform time segment.  

The resistance is the value of the resistor that is used to terminate the digitizer channel.  

The nominal bitweight is the typical bitweight as supplied from the manufacturer.  The 

number of bits is the bit resolution of the digitizer being tested. 

3. Add frequency bands by clicking on the Add button next to the results table at the bottom 

of the Test Viewer.  Double click on the table column header to modify the frequency 

band range.  The range may be entered as two values in Hertz separated by a dash.  The 

frequency bands are used for computing noise estimates within those bands. 

4. Record the waveform data for each of the desired digitizers whose inputs are terminated.  

Load the waveform for each of the channels into Waveform Viewer and select the 

desired waveform time segment to be used for each waveform.  The waveform time 

segments are independent across all of the digitizer channels. 

5. Make any desired changes to the PSD Parameters and overlay any desired models onto 

the spectra. 

6. Click the Compute button at the bottom of the test window.  The results of the analysis 

will appear in the table below the waveforms.  Separate tables are provided for the noise 

in volts, the noise in counts, and the maximum potential dynamic range.  In addition, 

horizontal theoretical bit-lines are overlaid on the PSD Viewer. 

7. Click the Apply button at the bottom of the test window.  The entirety of the test will be 

saved to the database. 

 

  



120  

12.2.10 Modified Noise Power Ratio Test 
 

The Modified Noise Power Ratio Test compares the performance of a digitizer to the 

performance of an ideal digitizer at various bit lengths by calculating the SNR as a function of 

signal power.  This test is able to demonstrate the linearity of a digitizer across a range of 

amplitudes. 
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Procedure: 

 

1. Select the desired Temperature Sensor and White Noise Generator Testbed 

components that are to be used in this test from within the appropriate pull-down list in 

the Test Metadata section. 

2. Enter the Full-scale voltage, nominal number of bits, Min. frequency, and Max. 

frequency parameters.  The full scale voltage is the peak-to-peak voltage range of the 

digitizer.  The nominal number of bits is the number of bits of the digitizer, i.e. 24.  The 

minimum and maximum frequency define the frequency band over which the MNPR is 

computed. 

3. Add amplitudes by clicking on the Add button next to the MNPR table.  Double click on 

color-coded amplitude table entry to enter the appropriate amplitude value. 

4. Record the waveform data for the pair of digitizer channels connected to the signal 

generator.  Cycle the signal generator through each of the chosen amplitudes, allowing 

for a sufficient duration at each amplitude setting. Load the waveforms for each of the 

channels into Waveform Viewer.  Select each amplitude section of the waveform data 

with the appropriate amplitude selection window. 

5. Click the Compute button at the bottom of the test window.  The results of the analysis 

will appear in the table and plot below the waveforms.  The NPR values should follow 

one of the bit-lines on the plot. 

6.  Click the Apply button at the bottom of the test window.  The entirety of the test will be 

saved to the database. 
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12.2.11 Relative Transfer Function Test 
 

The Relative Transfer Function Test measures the amount of channel-to-channel timing skew 

present on a digitizer.  The test is performed by feeding white noise into the digitizer channels.  
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Procedure: 

 

1. Select the desired Temperature Sensor and White Noise Generator Testbed 

components that are to be used in this test from within the appropriate pull-down list in 

the Test Metadata section. 

2. Enter the Time Segment Length and Frequency Range parameters.  The time segment 

length specifies the length of the selected waveform time segment.  The frequency range 

specifies the bandpass over which the channel skew will be computed. 

3.  Record the signal generator output on all of the desired digitizer channels 

simultaneously.  Load one of the waveforms into the Reference Waveform Viewer.  

Load the remaining waveforms into the Waveforms Viewer.  Select the desired 

waveform time segment to be used for the waveforms.  The waveform time segments are 

fixed across all of the digitizer channels. 

4. Click the Compute button at the bottom of the test window.  The results of the analysis 

will appear in the table below the waveforms.  

5. Click the Apply button at the bottom of the test window.  The entirety of the test will be 

saved to the database. 
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12.2.12 Seismic / Infrasound System Noise and Bandwidth Limited Dynamic 
Range Test 

 

The Seismic / Infrasound System Noise and Bandwidth Limited Dynamic Range Test measures 

the digitizer’s noise and dynamic range expressed in the units of a sensor. 
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Procedure: 

 

1. Select the desired Temperature Sensor Testbed component that is to be used in this test 

from within the appropriate pull-down list in the Test Metadata section. 

2. Select one or more Input Terminated Noise Tests from the list of tests for this digitizer. 

3. Select a single sensor response from the response list. 

4. Enter the digitizer Full Scale Voltage parameter.  The full scale voltage is the peak-to-

peak voltage range of the digitizer and is is used in computing the dynamic ranges. 

5. Add frequency bands by clicking on the Add button next to the results table at the bottom 

of the Test Viewer.  Double click on the table column header to modify the frequency 

band range.  The range may be entered as two values in Hertz separated by a dash.  The 

frequency bands are used for computing noise estimates within those bands. 

6. Click the Compute button at the bottom of the test window.  The results of the analysis 

will appear in the table below the waveforms.  Separate tables are provided for the noise 

in sensor units and the bandwidth limited dynamic range. 

7.  Click the Apply button at the bottom of the test window.  The entirety of the test will be 

saved to the database. 
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12.2.13 Sine Calibrator Amplitude Test 
 

The Sine Calibrator Amplitude Test measures the accuracy of the sinusoid amplitude that the 

digitizer’s calibrator can output. 

 

 
 

Procedure: 

 

1. Select the desired Temperature Sensor Testbed component that is to be used in this test 

from within the appropriate pull-down list in the Test Metadata section. 

2. Enter the Reference Frequency and Number of cycles for sine-fit parameters.  The 

reference frequency is the frequency of the sinusoid that the digitizer’s calibrator will be 

outputting.  The number of cycles for sine-fit determines the length of the waveform time 

segment. 

3.  Add amplitudes by clicking on the Add button next to the Amplitude table.  Double 

click on the color-coded column header to enter the appropriate amplitude value.  The 

voltage entered corresponds to the amplitude of the sinusoid that the digitizer’s calibrator 

will output.  A waveform time segment selection tool with matching color will appear 

within the waveform viewers for each frequency. 
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4. Record the waveform data for the digitizer’s calibrator output.  Cycle the calibrator 

through each of the chosen amplitudes, allowing for a sufficient duration at each 

amplitude setting. Load the waveforms for each of the channels into Waveform Viewer.  

Select each amplitude section of the waveform data with the appropriate amplitude 

selection window. 

5. Click the Compute button at the bottom of the test window.  The results of the analysis 

will appear in the table below the waveforms. 

6.  Click the Apply button at the bottom of the test window.  The entirety of the test will be 

saved to the database. 
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12.2.14 Sine Calibrator Current Amplitude Test 
 

The Sine Calibrator Current Amplitude Test measures the current output capacity of the 

digitizer’s calibrator.  The positive terminal of the calibrator output is connected to ground 

through a high precision resistor with a known resistance value.  The negative terminal of the 

calibrator output is connected directly to ground.  The voltage drop across the resistor is then 

measured in order to compute the current. 

  

 
 

 

Procedure: 

 

1. Select the desired Temperature Sensor Testbed component that is to be used in this test 

from within the appropriate pull-down list in the Test Metadata section. 

2. Enter the Reference Frequency, Resistance, and Number of cycles for sine-fit 

parameters.  The reference frequency is the frequency of the sinusoid that the digitizer’s 

calibrator will be outputting.  The resistance is the value of the resistor and is used to 

compute currents from voltage.  The number of cycles for sine-fit determines the length 

of the waveform time segment. 
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3.  Add amplitudes by clicking on the Add button next to the Amplitude table.  Double 

click on the color-coded column header to enter the appropriate amplitude value.    The 

voltage entered corresponds to the amplitude of the sinusoid that the digitizer’s calibrator 

will output.  A waveform time segment selection tool with matching color will appear 

within the waveform viewer for each amplitude. 

4. Record the waveform data for the digitizer’s calibrator output.  Cycle the calibrator 

through each of the chosen amplitudes, allowing for a sufficient duration at each 

amplitude setting. Load the waveforms for each of the channels into Waveform Viewer.  

Select each amplitude section of the waveform data with the appropriate amplitude 

selection window. 

5. Click the Compute button at the bottom of the test window.  The results of the analysis 

will appear in the table below the waveforms. 

6.  Click the Apply button at the bottom of the test window.  The entirety of the test will be 

saved to the database. 
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12.2.15 Sine Calibrator Frequency Test 
 

The Sine Calibrator Frequency Test measures the accuracy of the sinusoid frequency that the 

digitizer’s calibrator can output. 

 

 
 

 

Procedure: 

 

1. Select the desired Temperature Sensor Testbed component that is to be used in this test 

from within the appropriate pull-down list in the Test Metadata section. 

2. Enter the Reference Amplitude and Number of cycles for sine-fit parameters.  The 

reference amplitude is the amplitude of the sinusoid that the digitizer’s calibrator will be 

outputting.  The number of cycles for sine-fit determines the length of the waveform time 

segment. 

3.  Add frequencies by clicking on the Add button next to the Frequency table.  Double 

click on color-coded frequency column header to enter the appropriate frequency value.    

The frequency entered corresponds to the frequency of the sinusoid that the digitizer’s 

calibrator will output.  A waveform time segment selection tool with matching color will 

appear within the waveform viewer for each frequency. 
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4. Record the waveform data for digitizer’s calibrator output.  Cycle the calibrator through 

each of the chosen frequencies, allowing for a sufficient duration at each frequency 

setting. Load the waveforms for each of the channels into Waveform Viewer.  Select 

each frequency section of the waveform data with the appropriate frequency selection 

window. 

5. Click the Compute button at the bottom of the test window.  The results of the analysis 

will appear in the table below the waveforms. 

6.  Click the Apply button at the bottom of the test window.  The entirety of the test will be 

saved to the database. 
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12.2.16 Sine Calibrator Total Harmonic Distortion Test 
 

The Sine Calibrator Total Harmonic Distortion is performed identically to the Total Harmonic 

Distortion Test.  The only difference is that instead of using a low distortion oscillator, the 

digitizer is configured to generate its own sine wave from its calibrator and this signal is 

recorded by an independent calibrated meter.  The reason for performing this test is to quantify 

the expected THD levels when using the digitizer’s own calibrator.  When a digitizer has been 

placed in the field, the digitizer’s calibrator may be controlled remotely in order to reproduce this 

test without having to retrieve any equipment.  
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12.2.17 Time Tag Accuracy Test 
 

The Time Tag Accuracy Test measures the digitizer’s timing accuracy for the pulse per hour 

trigger output from an independent GPS Timing reference.  The timing trigger output from a 

GPS receiver is connected to an input channel of the digitizer. 
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Procedure: 

 

1. Select the desired Temperature Sensor and GPS Trigger Testbed components that are 

to be used in this test from within the appropriate pull-down list in the Test Metadata 

section. 

2.  Record the GPS timing trigger on all of the desired digitizer channels simultaneously.  

Load the waveforms into the Waveforms Viewer.  Select the desired waveform time 

segment to be used for the waveforms.  The time segments should include trigger over an 

hour transition.  The waveform time segments may be set independently for each of the 

digitizer channels. 

3.  Click the Compute button at the bottom of the test window.  The results of the analysis 

will appear in the table below the waveforms.  

4. Click the Apply button at the bottom of the test window.  The entirety of the test will be 

saved to the database. 
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12.2.18 Time Tag Drift Test 
 

The Time Tag Drift Test examines the digitizers timing accuracy while it has a stable GPS lock, 

how the timing accuracy drifts once it has lost GPS lock, and how the timing accuracy recovers 

once the digitizer has re-acquired GPS lock.   
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Procedure: 

 

1. Select the desired Temperature Sensor and GPS Trigger Testbed components that are 

to be used in this test from within the appropriate pull-down list in the Test Metadata 

section. 

2. Set the Time Segment Length and Time Tag Type parameters.  The time segment 

length specifies the length of the selected waveform time segment.  The time tag type 

specifies the type of triggers that are being analyzed. 

3.  Record the GPS timing trigger on the desired digitizer channels simultaneously.  Load a 

single waveform into the Waveform Viewer.  Select the desired waveform time segment 

to be used for the waveforms.  The time segments should include trigger over an hour 

transition.  The waveform time segments may be set independently for each of the 

digitizer channels.  

4.  Click the Compute button at the bottom of the test window.  The Time Tag Errors plot 

will be updated with the values computed from the selected waveform time segment. 

5. Select the Drift Period (red) and Recovery Period (green) using the appropriate time 

segment selection tools on the Time Tag Errors plot. 

6.  Click the Compute button at the bottom of the test window.  The results of the analysis 

will appear in the table below the waveforms.  

7. Click the Apply button at the bottom of the test window.  The entirety of the test will be 

saved to the database. 
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12.2.19 Time Tag Statistics Test 
 

The Time Tag Statistics Test measures the time tag error for many timing triggers, displays a 

histogram of the errors, and computes statistics of the errors. 
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Procedure: 

 

1. Select the desired Temperature Sensor and GPS Trigger Testbed components that are 

to be used in this test from within the appropriate pull-down list in the Test Metadata 

section. 

2. Set the Time Segment Length and Time Tag Type parameters.  The time segment 

length specifies the length of the selected waveform time segment.  The time tag type 

specifies the type of triggers that are being analyzed. 

3.  Record the GPS timing trigger on all of the desired digitizer channels simultaneously.  

Load the waveforms into the Waveforms Viewer.  Select the desired waveform time 

segment to be used for the waveforms. The waveform time segments may be set 

independently for each of the digitizer channels. 

4.  Click the Compute button at the bottom of the test window.  The results of the analysis 

will appear in the table below the waveforms.  

5. Click the Apply button at the bottom of the test window.  The entirety of the test will be 

saved to the database.  
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12.2.20 Total Harmonic Distortion Test 
 

The Total Harmonic Distortion Test measures the amount of distortion present in a pure sine 

wave from an ultra-low distortion oscillator that is fed into an input channel of a digitizer. 
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Procedure: 

 

1. Select the desired Temperature Sensor, Sine Generator, and Meter Testbed 

components that are to be used in this test from within the appropriate pull-down list in 

the Test Metadata section. 

2. Enter the Time Segment Length, Reference Voltage, Reference Frequency, and 

Maximum Harmonics parameters.  The time segment length specifies the length of the 

selected waveform time segment.  The reference voltage and frequency specify the 

voltage and frequency of the sinusoid from the sine generator.  The maximum harmonics 

limits the number of harmonics that will be examined in the power spectra when 

computing the total harmonic distortion.  

3. (Optional) Using the signal generator and meter, record a reference waveform.  Load that 

reference waveform into the Reference Waveform Viewer and select the desired 

waveform time segment to be used. 

4. Connect the signal generator to each of the digitizer channels and obtain the data by 

recording the sinusoid.  Once the data has been recorded, load the waveform into the 

Waveform Viewer.  Select the desired waveform time segments for sinusoid portions of 

the signal.  The waveform time segments may be set independently of one another.  

However, their lengths are all fixed to be the same. 

5. Click the Compute button at the bottom of the test window.  The results of the analysis 

will appear in the table below the waveforms.  Also, the power spectra plot will be 

updated with vertical markers identifying the harmonic peaks. 

6. Click the Apply button at the bottom of the test window.  The entirety of the test will be 

saved to the database. 
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12.3 Infrasound and Seismic Sensor Tests 
 

12.3.1 Infrasound Sensor Amplitude Response Test 
 

The Infrasound Sensor Amplitude Response Test measures the sensitivity of an infrasound 

sensor under test at multiple discrete amplitude values at a fixed tonal frequency.  

 

 



142  

 

Procedure: 

 

1. Select the desired Temperature Sensor, Signal Generator, Piston Phone, Isolation 

Chamber, Reference Infrasound Sensor, and Digitizer Testbed components that are to 

be used in this test from within the appropriate pull-down list in the Test Metadata 

section. 

2. Enter the Reference Frequency and Number of cycles for sine-fit parameters.  The 

reference frequency is the frequency of the sinusoid that the signal generator will be 

outputting.    The number of cycles for sine-fit and the sinusoid frequency are used in 

determining the length of the waveform time segment. 

3.  Add amplitudes by clicking on the Add button next to the Amplitude table.  Double 

click on the color-coded column header to enter the appropriate amplitude voltage value.  

The voltage values correspond to the amplitude of the sinusoids that the signal generator 

will be outputting.  A waveform time segment selection tool with matching color will 

appear within the waveform viewers for each amplitude. 

4. Record the waveform data for the reference infrasound sensor and the infrasound sensor 

under test.  Cycle the signal generator through each of the chosen amplitudes, allowing 

for a sufficient duration at each amplitude setting. Load the waveform for the reference 

infrasound sensor into the Reference Waveform Viewer and select the appropriate 

sensor response.  Load the waveform for the infrasound sensor under test into the Test 

Waveform Viewer. 

5. Select each amplitude section of the waveform data with the appropriate amplitude 

selection window.  The window lengths are fixed based upon the signal frequency and 

number cycles for sine fit.  The positions of each window are the same between the 

reference and test waveforms. 

6. Click the Compute button at the bottom of the test window.  The results of the analysis 

will appear in the tables and plots below the waveforms.  There are tabs for each result 

types:  Amplitude, Phase, DC Offset, Sensitivity, and SNR. 

7.  Click the Apply button at the bottom of the test window.  The entirety of the test will be 

saved to the database. 
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12.3.2 Infrasound Sensor Isolation Noise Test 
 

The Infrasound Sensor Isolation Noise Test measures the internal noise of an infrasound sensor 

under test when the ambient infrasound signals present are below the sensor noise.  The 

infrasound sensor is placed inside of a pressure isolation chamber.  The isolation chamber serves 

to attenuate any external ambient variations in pressure that would otherwise be recorded. 
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Procedure: 

 

1. Select the desired Temperature Sensor, Isolation Chamber(s), and Digitizer Testbed 

components that are to be used in this test from within the appropriate pull-down list in 

the Test Metadata section. 

2. Enter the Time Segment Length, and Peak Voltage parameters.  The time segment 

length specifies the length of the waveform time segment.  The peak voltage is the 

maximum signal output from the sensor under test.  This value should be obtained from 

the manufacturer’s datasheet. 

3. Add frequency bands by clicking on the Add button next to the results table at the bottom 

of the Test Viewer.  Double click on the table column header to modify the frequency 

band range.  The range may be entered as two values in Hertz separated by a dash.  The 

frequency bands are used for computing noise estimates within those bands. 

4. Record the waveform data for sensor under test.  Load the waveform for each of the 

channels into Waveform Viewer and select the appropriate sensor response.  Select the 

desired waveform time segment to be used. 

5. Make any desired changes to the PSD Parameters and overlay any desired models onto 

the spectra. 

6. Click the Compute button at the bottom of the test window.  The results of the analysis 

will appear in the table below the waveforms.  Separate tables are provided for the noise 

and the dynamic range. 

7. Click the Apply button at the bottom of the test window.  The entirety of the test will be 

saved to the database. 
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12.3.3 Infrasound Sensor Frequency Response Test 
 

The Infrasound Sensor Frequency Response Test measures the sensitivity of an infrasound 

sensor under test at multiple discrete frequency values. 
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Procedure: 

 

1. Select the desired Temperature Sensor, Signal Generator, Piston Phone, Isolation 

Chamber, Reference Infrasound Sensor, and Digitizer Testbed components that are to 

be used in this test from within the appropriate pull-down list in the Test Metadata 

section. 

2. Enter the Reference Amplitude and Number of cycles for sine-fit parameters.  The 

reference amplitude is the amplitude voltage of the sinusoid that the signal generator will 

be outputting.  The number of cycles for sine-fit and the sinusoid frequencies are used in 

determining the length of the waveform time segment. 

3.  Add frequencies by clicking on the Add button next to the Amplitude table.  Double 

click on the color-coded column header to enter the appropriate frequency value in Hertz.  

The frequencies correspond to the frequencies of the sinusoids that the signal generator 

will be outputting.  A waveform time segment selection tool with matching color will 

appear within the waveform viewers for each frequency. 

4. Record the waveform data for the reference infrasound sensor and the infrasound sensor 

under test.  Cycle the signal generator through each of the chosen frequencies, allowing 

for a sufficient duration at each frequency setting. Load the waveform for the reference 

infrasound sensor into the Reference Waveform Viewer and select the appropriate 

sensor response.  Load the waveform for the infrasound sensor under test into the Test 

Waveform Viewer. 

5. Select each frequency section of the waveform data with the appropriate frequency 

selection window.  The window lengths are fixed based upon the signal frequency and 

number cycles for sine fit.  The positions of each window are the same between the 

reference and test waveforms. 

6. Click the Compute button at the bottom of the test window.  The results of the analysis 

will appear in the tables and plots below the waveforms.  There are tabs for each result 

types:  Amplitude, Phase, DC Offset, Sensitivity, and SNR. 

7.  Click the Apply button at the bottom of the test window.  The entirety of the test will be 

saved to the database. 
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12.3.4 Seismic / Infrasound Sensor Response Verification Test 
 

The Seismic / Infrasound Sensor Response Verification Test measures the response of a seismic 

or infrasound sensor under test relative to a reference sensor.  The sensor under test and the 

reference sensor with known response characteristics are co-located so that they are both 

measuring a common signal. 
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Procedure: 

 

1. Select the desired Temperature Sensor, Digitizer, and Reference Sensor Testbed 

components that are to be used in this test from within the appropriate pull-down list in 

the Test Metadata section. 

2. Enter the Time Segment Length and Noise Model parameters.  The time segment length 

specifies the length of the waveform time segment.  The noise model specifies whether 

noise is distributed between the two sensors or lumped into the test sensor for coherence 

analysis. 

3. Record the waveform data for the reference and test sensors.  Load the waveform for the 

reference sensor into the Reference Waveform Viewer and select the appropriate sensor 

response.  Load the waveform for the sensor under test into the Test Waveform Viewer 

and select the appropriate sensor response. 

4. Select the desired waveform time segment to be used for each of the waveforms.  The 

waveform time segments are fixed to be identical between the reference and test 

waveforms. 

5. Make any desired changes to the PSD Parameters and overlay any desired models onto 

the spectra. 

6. Click the Compute button at the bottom of the test window.  The results of the analysis 

will appear in the plots of coherence, relative magnitude, and relative phase. 

7. Click the Apply button at the bottom of the test window.  The entirety of the test will be 

saved to the database. 
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12.3.5 Seismic / Infrasound Sensor Self-Noise 2C Test 
 

The Seismic / Infrasound Sensor Self-Noise 2C Test measures the noise level of a seismic sensor 

under test relative to one reference sensors.  The sensors are all co-located so that they are 

measuring a common signal. 
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Procedure: 

 

1. Select the desired Temperature Sensor, Digitizer, and Reference Sensor Testbed 

components that are to be used in this test from within the appropriate pull-down list in 

the Test Metadata section. 

2. Enter the Time Segment Length, Noise Model, and Peak Voltage parameters.  The time 

segment length specifies the length of the waveform time segment.  The noise model 

specifies whether noise is distributed between the two sensors or lumped into the test 

sensor for coherence analysis.  The peak voltage is the maximum signal output from the 

sensor under test.  This value should be obtained from the manufacturer’s datasheet. 

3. Add frequency bands by clicking on the Add button next to the results table at the bottom 

of the Test Viewer.  Double click on the table column header to modify the frequency 

band range.  The range may be entered as two values in Hertz separated by a dash.  The 

frequency bands are used for computing noise estimates within those bands. 

4. Record the waveform data for the reference and test sensors.  Load the waveform for the 

reference sensor into the Reference Waveform Viewer and select the appropriate sensor 

response.  Load the waveform for the sensor under test into the Test Waveform Viewer 

and select the appropriate sensor response. 

5. Select the desired waveform time segment to be used for each of the waveforms.  The 

waveform time segments are fixed to be identical between the reference and test 

waveforms. 

6. Make any desired changes to the PSD Parameters and overlay any desired models onto 

the spectra. 

7. Click the Compute button at the bottom of the test window.  The results of the analysis 

will appear in the plots of coherence and noise.  A table of noises and dynamic ranges for 

each of the defined frequency bands will also be generated. 

8. Click the Apply button at the bottom of the test window.  The entirety of the test will be 

saved to the database. 
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12.3.6 Seismic / Infrasound Sensor Self-Noise 3C Test 
 

The Seismic / Infrasound Sensor Self-Noise 3C Test measures the noise level of a seismic sensor 

under test relative to two reference sensors.  The sensors are all co-located so that they are 

measuring a common signal. 
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Procedure: 

 

1. Select the desired Temperature Sensor, Digitizer, Reference Sensor 1 and Reference 

Sensor 2 Testbed components that are to be used in this test from within the appropriate 

pull-down list in the Test Metadata section. 

2. Enter the Time Segment Length and Peak Voltage parameters.  The time segment 

length specifies the length of the waveform time segment.  The peak voltage is the 

maximum signal output from the sensor under test.  This value should be obtained from 

the manufacturer’s datasheet. 

3. Add frequency bands by clicking on the Add button next to the results table at the bottom 

of the Test Viewer.  Double click on the table column header to modify the frequency 

band range.  The range may be entered as two values in Hertz separated by a dash.  The 

frequency bands are used for computing noise estimates within those bands. 

4. Record the waveform data for the reference and test sensors.  Load all three waveforms 

into the Test Waveform Viewer and select the appropriate sensor responses. 

5. Select the desired waveform time segment to be used for each of the waveforms.  The 

waveform time segments are fixed to be identical across all of the waveforms. 

6.  Make any desired changes to the PSD Parameters and overlay any desired models onto 

the spectra. 

7. Click the Compute button at the bottom of the test window.  The results of the analysis 

will appear in the plots of coherence and noise.  A table of noises and dynamic ranges for 

each of the defined frequency bands will also be generated. 

8. Click the Apply button at the bottom of the test window.  The entirety of the test will be 

saved to the database. 
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12.3.7 Seismic / Infrasound Sensor Total Harmonic Distortion Test 
 

The Seismic / Infrasound Sensor Total Harmonic Distortion Test is performed identically to the 

Total Harmonic Distortion Test.  The only difference is that an additional source generator, such 

as a piston phone or shake table, is used to supply a sinusoidal signal to the sensor under test. 
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12.4 Subsystem Tests 
 

12.4.1 Sensor Subsystem DC Accuracy Test 
 

The Sensor Subsystem DC Accuracy Test is the same as the Digitizer DC Accuracy Test.  

However, it has an additional component association to select a Digitizer component.  The 

contents of the Digitizer pull-down list in the Test Metadata section are obtained from the 

subsystem for this test. 

 

12.4.2 Sensor Subsystem Input Terminated Noise / Maximum Potential Dynamic Range 
Test 

 

The Sensor Subsystem Input Terminated Noise / Maximum Potential Dynamic Range Test is the 

same as the Digitizer Input Terminated Noise Test and Maximum Potential Dynamic Range 

Test.  However, it has an additional component association to select a Digitizer component.  The 

contents of the Digitizer pull-down list in the Test Metadata section are obtained from the 

subsystem for this test. 

 

12.4.3 Sensor Subsystem Time Tag Accuracy Test 
 

The Sensor Subsystem Time Tag Accuracy Test is the same as the Digitizer Time Tag Accuracy 

Test. However, it has an additional component association to select a Digitizer component.  The 

contents of the Digitizer pull-down list in the Test Metadata section are obtained from the 

subsystem for this test. 

 

12.4.4 Sensor Subsystem Time Tag Drift Test 
 

The Sensor Subsystem Time Tag Drift Test is the same as the Digitizer Time Tag Drift Test.  

However, it has an additional component association to select a Digitizer component.  The 

contents of the Digitizer pull-down list in the Test Metadata section are obtained from the 

subsystem for this test. 

 

12.4.5 Sensor Subsystem Seismic / Infrasound System Noise and Bandwidth Limited 
Dynamic Range Test 

 

The Sensor Subsystem Seismic / Infrasound System Noise and Bandwidth Limited Dynamic 

Range Test is the same as the Seismic / Infrasound System Noise and Bandwidth Limited 

Dynamic Range Test.  However, it has an additional component association to select a Digitizer 

component.  The contents of the Digitizer pull-down list in the Test Metadata section are 

obtained from the subsystem for this test. 

 

12.4.6 Sensor Subsystem Seismic/Infrasound Self Noise 2-Channel Test 
 

The Sensor Subsystem Seismic/Infrasound Self Noise 2-Channel Test is the same as the Seismic 

/ Infrasound Sensor Self-Noise 2C Test.  However, it has additional component associations to 
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select a Digitizer component and a Sensor components.  The contents of the digitizer and sensor 

pull-down lists in the Test Metadata section are obtained from the subsystem for this test. 

 

12.4.7 Sensor Subsystem Seismic/Infrasound Self Noise 3-Channel Test 
 

The Sensor Subsystem Seismic/Infrasound Self Noise 3-Channel Test is the same as the Seismic 

/ Infrasound Sensor Self-Noise 3C Test.  However, it has additional component associations to 

select a Digitizer component and a Sensor component.  The contents of the digitizer and sensor 

pull-down lists in the Test Metadata section are obtained from the subsystem for this test. 

 

12.4.8 Sensor Subsystem Seismic/Infrasound Response Verification Test 
 

The Sensor Subsystem Seismic/Infrasound Response Verification Test is the same as the Seismic 

/ Infrasound Sensor Response Verification Test.  However, it has additional component 

associations to select a Digitizer component and a Sensor component.  The contents of the 

digitizer and sensor pull-down lists in the Test Metadata section are obtained from the subsystem 

for this test. 
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